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Getting Started

 

Congratulations on purchasing your new high- 
performance Power Mac G5 computer. This chapter 
contains instructions for setting up your computer 
and display.

 

Your Power Mac G5 features the latest computer technology, including an advanced 
64-bit processor, high-speed memory, an AGP 8X Pro graphics card for stunning visuals, 
and Serial ATA internal storage, all in an anodized aluminum chassis with easy access to 
internal components. 

 

Positioning the Computer and Display

 

Pick up the computer by both of its handles using correct lifting techniques. If your 
display is heavy, use correct lifting techniques when positioning it as well. Position the 
computer and display so that:
Â

 

They are on sturdy, flat surfaces
Â

 

The power cable connectors don’t press against a wall or other object
Â

 

The airflow in front of, behind, or below the display or computer is not obstructed
Â

 

The computer’s optical drive tray has space to open in front

The only way to shut off power completely to your computer and display is to 
disconnect their power plugs from the power source. Make sure the power cords for 
your computer and display are within easy reach so that you can unplug the computer 
or display when you need to.

 

Warning:  

 

Apple recommends that you operate your Power Mac G5 in an upright 
position with the side panel in place. The computer does not operate properly when 
it is placed on its side or when the side panel is removed.
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Setting Up

 

Your Power Mac G5 is designed so you can set it up quickly and start using it right 
away.

 

1

 

Remove any protective film from the outside of your computer and from the inside of 
the side panel. For instructions about opening the side panel, see “Opening the 
Computer” on page 44.

 

2

 

Plug the power cord firmly and completely into the recessed power cord socket on the 
back of the computer and plug the other end into a grounded outlet or power strip.

Power cord plug

Power cord socket
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3

 

Connect your display cables according to the following illustration. Depending on your 
display, you may have one or more cables to connect. Check the instructions that came 
with the display for further setup information.

You can connect two displays to the video card in your computer.

If your graphics card has two DVI ports, you can also connect displays with an Apple 
Display Connector (ADC), a video graphics array (VGA) connector, or connect a video 
device using one of the following display adapters:

Â

 

To connect a VGA display, use a DVI to VGA adapter (supplied with your computer) to 
connect the display to the DVI port.

Â

 

To connect an ADC display, use a DVI to ADC adapter (not included) to connect the 
display to the DVI port.

Â

 

To connect a television, VCR, or other video device, use a DVI to Video adapter (not 
included) to connect the device to the DVI port (see “Connecting a Television, VCR, or 
Other Video Device” on page 25).

For more information about connecting a display, see the guidelines in Chapter 2, 
“Using Your Computer.”

USB port

FireWire 400 port

Display cable

Display ports

DVI display ports
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4

 

To access the Internet or a network, connect your computer to a DSL or cable modem, 
or to an Ethernet network. If you have a modem, connect your modem to an analog 
phone line.

Modem port

Ethernet port
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5

 

Connect the keyboard cable to one of the USB ports (d

 

) on the computer or on your 
display. Plug the mouse cable into a USB port on the keyboard.

 

Note:  

 

If the keyboard cable is not long enough to reach a USB port on your computer, 
you can use the keyboard extension cable that came with your computer.

 

6

 

Turn on your computer by pressing the power button (®

 

) on the front. With some 
Apple displays, you can also turn on the computer using the display’s power button. If 
your display must be turned on separately, turn it on by pressing its power button.

 

Using a Wireless Keyboard and Mouse

 

If you purchased an Apple Wireless Keyboard and Apple Wireless Mouse with your 
Power Mac G5, connect the Bluetooth antenna that came with your computer to the 
Bluetooth antenna port (◊

 

) on the back of your Power Mac G5. Follow the instructions 
that came with the keyboard and mouse to set them up with your computer.

Keyboard Mouse

You may see several strips of clear plastic
film on the inside of the side panel (used
to protect the side panel during shipment).
Open the side panel and remove the film.

Plug the mouse into either
USB port located on the
back of the keyboard.

Apple keyboard extension cable
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Adjusting Your Display

 

To adjust the settings for your display, choose Apple (

 

) > System Preferences and click 
Displays.

For information about troubleshooting your display, see “Problems With Your Display” 
on page 74. For information about maintaining your display, see “Maintaining Your 
Display” on page 88. Additional information about using your display is available in 
Mac Help. 

 

Need Help?

 

If you don’t see anything on your screen or you think your computer did not start up 
properly, check these items:
Â

 

Is the computer plugged into a power source? If it is plugged into a power strip, is 
the power strip turned on?

Â

 

Is the power cord securely plugged into the back of the computer? 
Â

 

Are the keyboard and display cables connected correctly? 
Â

 

Is the display turned on? Are the brightness and contrast controls on the display 
adjusted correctly? If your display has brightness and contrast controls, adjust them.

Â

 

Restart your computer. Press and hold the computer’s power button for 
approximately 5 seconds until the computer turns off. Press it again to turn the 
computer on.

Â

 

If you see a blinking question mark on the screen or see a series of flashes from the 
status light when you turn on the computer, see Chapter 4, “Troubleshooting,” on 
page 71.
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What’s Next?

 

You’ve done everything you need to get your Power Mac G5 up and running. The first 
time you turn on your computer, the Setup Assistant starts. The Setup Assistant helps 
you enter your Internet and email information and set up an account on your 
computer. If you have another Mac, the Setup Assistant can also help you transfer files, 
applications, and other information from your old Mac to your new Power Mac G5.

 

Transferring Information to Your Power Mac G5

 

You can use the Setup Assistant to automatically transfer information from another 
Mac to your new Power Mac G5. To transfer information, make sure of the following:
Â

 

Your other Mac must have built-in FireWire and support FireWire Disk Mode.
Â

 

Your other Mac must have Mac OS X v10.1 or later installed.
Â

 

You must have a FireWire cable to connect the two computers.

The Setup Assistant takes you through the process of transferring your information—
just follow the onscreen instructions. Transferring information to your Power Mac G5 
does not affect the information on your other Mac. You can transfer:
Â User accounts, including preferences and email
Â Network settings, so your new computer is automatically set up to work with 

the same network settings as your other Mac
Â The Applications folder, so that all of the applications you used on your other Mac 

are now on your new Power Mac G5 (you may have to reinstall some of the 
applications you transfer)

Â Files and folders stored on your hard disk

If you don’t use the Setup Assistant to transfer information when you first start up your 
Power Mac G5, you can do it later using the Migration Assistant. Open the Applications 
folder, open Utilities, and double-click the Migration Assistant icon.

Note:  If you transfer information later using the Migration Assistant, make sure File 
Vault is turned off on the older computer. To turn off File Vault, choose Apple () > 
System Preferences, click Security, and follow the onscreen instructions.
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Setting Up Your Power Mac G5 for the Internet
If you didn’t transfer your user account and network settings information, the Setup 
Assistant takes you through the process of configuring your computer and setting it up 
for the Internet. For home users, Internet access requires an account with an Internet 
service provider (ISP). Fees may apply. If you have an Internet account, see Appendix C, 
“Connecting to the Internet,” on page 91 for information you’ll need to enter.

What to Do When You Have Finished Working
When you have finished working with your Power Mac G5, you can put your computer 
to sleep or shut it down.

Putting Your Power Mac G5 to Sleep
If you will be away from your Power Mac G5 for only a short time, put the computer to 
sleep. When the computer is in sleep, the display’s screen is dark. You can quickly wake 
the computer from sleep and bypass the startup process.

To put the computer to sleep quickly, do one of the following:
Â Choose Apple () > Sleep. 
Â Press the power button on the front of your Power Mac G5.
Â Choose Apple () > System Preferences, click Energy Saver, and set a sleep timer. 

To wake your computer from sleep, do one of the following:
Â Press any key on the keyboard.
Â Click the mouse.
For more information on sleep, see “Putting the Computer to Sleep to Save Energy” on 
page 40. 

LL3218Q87.book  Page 12  Wednesday, March 16, 2005  6:28 PM



Chapter 1    Getting Started 13

 

Shutting Down Your Power Mac G5
If you will not use your Power Mac G5 for a day or two, you should turn it off. 

To turn off your computer:
m Choose Apple () > Shut Down.

Warning:  Do not turn off the computer by turning off the switch on a power strip or 
by pulling out the computer’s power plug (unless you can’t turn off the computer any 
other way). Your files or system software could be damaged if your computer is not 
shut down properly.

Warning:  Shut down your Power Mac G5 before moving it. Moving your computer 
while the hard disk is spinning can damage the hard disk, causing loss of data or the 
inability to start up from the hard disk.
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Getting to Know Your Computer

Optical drive

Headphone jackf

® Power button

Status light

USB 2.0 port
FireWire 400 port
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Optical drive
Your computer has a DVD-ROM/CD-RW Combo drive or a DVD+R DL/DVD±RW/CD-RW SuperDrive. 
Each drive can read CD-ROM discs, photo CDs, standard audio discs, and other kinds of media. The 
Combo drive can also read DVD discs and DVD movies and can write music, documents, and other 
digital files to CD-R and CD-RW discs. In addition to those files, the SuperDrive can also read and write 
to DVD±R, DVD±RW, and DVD+R Double Layer (DL) discs.
To open the optical drive, press the Media Eject (C) key on your Apple Keyboard.

Status light
A white light indicates that the computer is on; a pulsing light indicates the computer is in sleep.

® Power button
Press this button to turn on your Power Mac G5, put it to sleep, or wake it from sleep. To restart your 
computer, press and hold this button for approximately 5 seconds until the computer turns off, then 
press it again to turn the computer on.
With some Apple displays, you can also touch or press the display’s power button to turn the 
computer on or put it to sleep.

H FireWire 400 port
Connect your Macintosh to FireWire devices, including an iPod, digital videocameras, and hard disk 
drives. FireWire provides high-speed data transfer for them all. The FireWire 400 port supports data 
rates of 100, 200, and 400 megabits per second (Mbps).

f Headphone jack
Connect headphones to your Macintosh through the headphone jack. When a plug is inserted into 
the headphone jack, the built-in speaker is muted.

d USB 2.0 port
Connect your Macintosh to USB devices, such as keyboards, mice, printers, scanners, speakers, USB 
microphones, and USB hubs. Your display may also have USB ports.

LL3218Q87.book  Page 15  Wednesday, March 16, 2005  6:28 PM



16 Chapter 1    Getting Started

 

Ports and Connectors—Expanding Your Computer’s Capabilities

Latch Access covers for PCI
expansion slots

DVI display port

AirPort antenna port

Bluetooth antenna port

Internal modem port
(on some models)

Optical digital
audio out port

Optical digital
audio in port

Power socket

DVI display port

USB 2.0 ports (2)

FireWire 400 port

W

-

√

GFireWire 800 port Ethernet port

Audio line-out port

Audio line-in port
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¥ Latch 
Lift the latch to open the side panel and access the internal components in your Power Mac G5. You 
can also attach a security lock to the latch to secure the internal components.

£ DVI display port
Connect displays that use a Digital Visual Interface (DVI) connector. You can connect displays that use 
a video graphics array (VGA) connector with the DVI to VGA Adapter that came with your computer.

Z AirPort Extreme antenna port
Connect the AirPort Extreme antenna to this port if your Macintosh has an optional AirPort Extreme 
Card installed.

◊ Bluetooth antenna port 
Connect the small cylindrical Bluetooth® antenna that came with your computer if your Power Mac G5 
has an optional Bluetooth module installed.

d USB 2.0 ports
Connect your Macintosh to USB devices, such as keyboards, mice, printers, scanners, speakers, USB 
microphones, and USB hubs. Your Apple Keyboard and your display may also have USB ports.

H FireWire 400 and 800 ports
The FireWire 400 port supports data rates of 100, 200, and 400 Mbps. The FireWire 800 port supports 
data rates of 100, 200, 400, and 800 Mbps.

Power socket
Connect the computer’s power cord.

Access covers for PCI expansion slots (3)
Expand your Macintosh by installing up to three Peripheral Component Interconnect (PCI) cards in the 
covered slots labeled 2, 3, and 4. 

Optical digital audio out port
Connect your Macintosh to a receiver or other digital audio devices.

Optical digital audio in port
Connect your Macintosh to digital audio devices, such as CD players and minidisc players.

- Analog audio line-out port
Connect self-powered MP3, CD, and other audio equipment to your Macintosh. 

, Analog audio line-in port
Connect self-powered microphones and other audio equipment to your Macintosh. 

G 10/100/1000 twisted-pair Ethernet port 
Connect your Macintosh to a high-speed Ethernet network to access the Internet or network 
resources such as printers and servers, and share information over the network.

W Internal modem port
Connect a standard phone line if your Macintosh has an optional internal 56K V.92 modem.
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Inside Your Power Mac G5—Your Computer’s Internal Expansion Options

Bottom hard disk drive bay

Top hard disk drive bayOptical drive

Slot 1: AGP 8X Pro slot
(graphics card installed)

DDR SDRAM slots
(either 4 or 8 slots,
depending on model)

Slots 2–4: PCI or PCI-X slots
(depending on model)

Battery

AirPort Extreme
Card connector
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Optical drive
Your computer comes with a DVD-ROM/CD-RW Combo drive or a DVD+R DL/DVD±RW/CD-RW 
SuperDrive. For information about the optical drive, see “Using Your Optical Drive” on page 31.

Battery
Your computer uses a battery that you rarely need to replace. If your computer has trouble starting 
up, or the system date and time are frequently incorrect, you may need to replace the battery. For 
more information, see “Replacing the Battery” on page 69.

AirPort Extreme Card connector
Connect an AirPort Extreme Card, which allows your computer to communicate with a 
network wirelessly. For more information, see “Installing an AirPort Extreme Card” on page 68.

DDR SDRAM slots
Depending upon the model, your computer has 4 or 8 DDR SDRAM slots. You can add additional 
memory by inserting DDR SDRAM DIMMs in pairs in the memory slots. For more information, see 
“Installing Memory” on page 49.

Hard disk drive bays
Your computer comes with a hard disk drive installed in the top hard disk drive bay. You can install an 
additional hard disk drive in the bottom hard disk drive bay. You can have up to two Serial ATA drives 
in the computer. For more information, see “Installing Internal Storage Devices” on page 56.

PCI or PCI-X slots
Depending upon the model, your computer has PCI or PCI-X expansion slots, for a total of three slots. 
You can install PCI cards in slots 2 through 4 to expand your computer’s capabilities. For more 
information, see “Installing a PCI Expansion Card or Replacing the AGP Card” on page 64.

AGP 8X Pro slot
Connect your display through the card in the advanced graphics port (AGP) 8X Pro slot, which 
provides accelerated graphics processing power. For more information, see “Connecting Displays, 
Televisions, and Video Devices” on page 23 or “Installing a PCI Expansion Card or Replacing 
the AGP Card” on page 64.
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Additional Information
If you would like additional information, see the following:

To learn about... See...

Shutting down your computer 
or putting it to sleep

“What to Do When You Have Finished Working” on page 12.

Using a specific hardware 
feature of your Power Mac G5

Chapter 2, “Using Your Computer,” on page 21.

Installing additional drives, 
memory, and cards, or changing 
the battery

Chapter 3, “Working Inside Your Computer,” on page 43.

Troubleshooting your computer 
if you have a problem

Chapter 4, “Troubleshooting,” on page 71.

Installing Mac OS 9 to use 
Mac OS 9 applications with your 
computer

“Installing Mac OS 9” on page 77.

Connecting your computer to 
the Internet

Appendix C, “Connecting to the Internet,” on page 91.
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2 Using Your Computer

This chapter provides instructions for using the 
important features of your Power Mac G5 computer, 
including your keyboard, mouse, FireWire, USB, audio, 
Bluetooth wireless technology, and networking. 

Explanations are provided for:
Â “Using Your Apple Keyboard” on page 22
Â “Using Your Apple Mouse” on page 23
Â “Connecting Displays, Televisions, and Video Devices” on page 23
Â “Using Universal Serial Bus (USB)” on page 26
Â “Using FireWire” on page 28
Â “Using Audio Devices” on page 30
Â “Using Your Optical Drive” on page 31
Â “Using Your Modem” on page 36
Â “Connecting to an Ethernet Network” on page 34
Â “Using AirPort Wireless Networking” on page 36
Â “Using Bluetooth Wireless Technology” on page 38
Â “Transferring Information Between Two Macintosh Computers” on page 41
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Using Your Apple Keyboard
Your Apple Keyboard comes with function keys preset for common tasks. Press the 
Media Eject (C) key to eject discs from the optical drive. Press the Volume Up or Volume 
Down keys to adjust the sound level or press the Mute key to turn sound on or off. Use 
the Brightness Up and Brightness Down keys to adjust the level of brightness on an 
Apple display.

Note:  Press the F12 key on a non-Apple keyboard to eject optical discs.

The Apple Keyboard has two Universal Serial Bus (USB) 1.1 ports. You can plug your 
mouse cable or other USB devices in the USB ports at the back of the keyboard. 

If you purchased an Apple Wireless Keyboard with your Power Mac G5, connect the 
Bluetooth antenna that came with your computer to the Bluetooth antenna port on 
the back of your computer. Follow the instructions that came with your keyboard for 
more information.

For More Information About Your Keyboard
Additional information about your keyboard is available in Mac Help. Choose Help > 
Mac Help and search for “keyboard.” 

Function keys

Volume Down key

Volume Up key-

Brightness Down key

Brightness Up key

Mute key—

Media Eject key

Keyboard cable

USB ports
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Using Your Apple Mouse
Your Apple Mouse uses optical tracking. To position the pointer using your mouse, 
move the mouse over any suitable surface such as your desktop, mouse pad, or other 
textured surface. (Some smooth, glassy surfaces provide less pointer control than 
others.) To click an object, press down once on the mouse body until you feel a click. To 
double-click an item, press down twice in quick succession. 

Note:  If you purchased an Apple Wireless Mouse with your Power Mac G5, connect the 
Bluetooth antenna that came with your computer to the Bluetooth antenna port on 
the back of your computer. Follow the instructions that came with your mouse for 
more information.

For More Information About Your Mouse
Additional information about your mouse is available in Mac Help. Choose Help > Mac 
Help and search for “mouse.”

Connecting Displays, Televisions, and Video Devices
You can connect two displays to your graphics card and use both displays at the same 
time. When a second display is connected, you can either have the same image appear 
on both displays (known as mirroring) or use the second display to extend the size of 
the Mac OS X desktop (known as extended desktop mode). You need the appropriate 
cable for each display you want to connect. 

To use multiple displays:
1 Turn off the displays and shut down your computer.

2 Connect the video cable from each display to the port on the graphics card.

3 Turn on the displays and start up your computer.

To adjust the displays, choose Apple () > System Preferences and click Displays. By 
default, your computer starts up in extended desktop mode. To work in mirroring 
mode, choose Apple () > System Preferences, click Displays, and choose Mirroring.

If you run out of room and want to
keep the mouse clicked while you
lift it, click the mouse, then squeeze
the sides with your thumb and
fingers as you lift.
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Using the Ports on Your Graphics Card
The graphics cards used with the Power Mac G5 have unique ports with different 
capabilities. Use System Profiler to determine which graphics card is installed in your 
Power Mac G5.

To open System Profiler:
1 Choose Apple () > About This Mac.

2 Click More Info.

3 Select Graphics/Displays. 

Use the guidelines in the table below to determine the type of ports on your graphics 
card.

You can connect a video device using the DVI to Video Adapter to ports with TV-out 
capability. For more information, see “Connecting a Television, VCR, or Other Video 
Device” on page 25.

Graphics card Port 2 Port 1

ATI Radeon 9600 single-link DVI single-link DVI
TV out

ATI Radeon 9650 dual-link DVI single-link DVI
TV out

NVIDIA GeForce 6800 Ultra DDL dual-link DVI
TV out

dual-link DVI
TV out

ATI Radeon X850 XT dual-link DVI
TV out

ADC

DVI display ports

ADC display portDVI display port
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Connecting a Television, VCR, or Other Video Device
You can connect your Power Mac G5 to a television, VCR, projector, or other external 
video device using the DVI to Video Adapter. The DVI to Video Adapter is available from 
your Apple Authorized Reseller, an Apple retail store, or online from the Apple Store at 
www.apple.com/store. 

To connect a video device:
1 Turn off the video device and shut down your computer.

2 Connect the DVI end of the DVI to Video Adapter to the DVI port that supports TV-out 
on your Power Mac G5 graphics card (see the table on page 24). 

3 Connect the other end of the adapter to the Composite (RCA) video port or the S-video 
port on the TV, VCR, or projector.

4 Turn on the video device and start up your computer.
To adjust the image, choose Apple () > System Preferences and click Displays. 

For More Information on Displays
For information about connecting your display, see the setup instructions in Chapter 1, 
“Getting Started.”

Additional information on using and configuring an external display is available in Mac 
Help. Choose Help > Mac Help and search for “display.” 

DVI display port

S-video out port

DVI to Video adapter

Composite video out port
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Using Universal Serial Bus (USB)
Your Power Mac G5 comes with three USB 2.0 ports; one on the front and two on the 
back. Your Apple Keyboard also has two USB 1.1 ports. You can use USB ports to 
connect many types of external devices, including printers, scanners, digital cameras, 
microphones, game pads, joysticks, keyboards, mice, and storage devices. USB makes it 
easy to connect external equipment. In most cases, you can connect and disconnect a 
USB device while the computer is running. Once you connect the device, it is ready to 
use. You don’t need to restart your computer. 

Using USB Devices
Apple has already included software to work with many USB devices. In most cases, 
you do not need to install the software that came with the device. When you connect a 
USB device, if your Power Mac G5 cannot find the correct software, you can either 
install the software that came with the device or contact the device manufacturer to 
locate, download, and install the correct software.

USB 2.0 ports
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Connecting Multiple USB Devices
If you want to connect more than three USB devices, you can purchase a USB hub. The 
USB hub connects to an open port on your computer and provides additional USB 
ports (usually four or seven). 

Note:  To use certain USB devices, you may need a powered USB hub.

For More Information on USB
Additional information on USB is available in Mac Help. Choose Help > Mac Help and 
search for “USB.” You can also find information on the Apple USB website at 
www.apple.com/usb. 

For information on USB devices available for your computer, go to the Macintosh 
Products Guide at www.apple.com/guide. 

USB hub

LL3218Q87.book  Page 27  Wednesday, March 16, 2005  6:28 PM



28 Chapter 2    Using Your Computer

 

Using FireWire 
FireWire is a high-speed data transfer system that lets you easily connect and 
disconnect external devices—such as iPod, digital music players, digital video (DV) 
cameras, printers, scanners, and hard disk drives. You can connect and disconnect 
FireWire devices without restarting your computer. Your computer includes three 
external FireWire ports.
Â Two FireWire 400 ports, one on the front and one on the back, support a maximum 

data rate of up to 400 megabits per second (Mbps).
Â One high-speed FireWire 800 port on the back supports a maximum data rate of up 

to 800 megabits per second (Mbps).

The FireWire 800 port on your Power Mac G5 transfers data from 800 Mbps FireWire 
devices much faster than was possible before. This port has a 9-pin connector, and is 
compatible with original FireWire devices with 6-pin or 4-pin connectors.

With an appropriate cable, the 9-pin port works seamlessly with all FireWire devices. 
Cables are available for connecting the 9-pin port to 4-pin, 6-pin, and 9-pin devices.

FireWire 400 ports

FireWire 800 port

FireWire 400 (6-pin) FireWire 400 (4-pin) FireWire 800 (9-pin)
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Using FireWire Devices
With FireWire you can:
Â Connect a FireWire digital videocamera and capture or transfer high-quality video 

directly to or from your computer. Then use video-editing software such as iMovie to 
edit the video. 

Â Connect an external FireWire hard disk drive to back up data or transfer files. A disk 
drive with the FireWire icon appears on your desktop after you connect the hard disk 
drive to your Power Mac G5. Some FireWire hard disk drives get their power through 
the FireWire cable, so you don’t need to connect an external power supply.

Â If you have a problem with your computer that prevents you from starting up or you 
want to transfer files, you can use FireWire to connect your Power Mac G5 to another 
computer so that your Power Mac G5 appears as an external hard disk on the other 
computer (a feature known as FireWire Target Disk Mode). See “FireWire Target Disk 
Mode,” next, for more information.

To use a FireWire device, connect the device to the computer and install any software 
that came with the device. Your computer automatically detects when you connect a 
new device. 

To start up from a FireWire hard disk that has Mac OS X on it, choose Apple () > 
System Preferences, click Startup Disk, and select the FireWire hard disk. 

If your FireWire hard disk doesn’t appear or can’t be selected, consult the FireWire hard 
disk vendor for updated software drivers.

To disconnect your FireWire hard disk safely, drag its icon to the Trash before 
disconnecting the FireWire cable.

FireWire Target Disk Mode
If you want to transfer files between your Power Mac G5 and another FireWire-
equipped computer, or you have a problem that prevents your computer from starting 
up, you can use FireWire Target Disk Mode to connect your Power Mac G5 to another 
computer.

Note:  Your Power Mac G5 can operate in FireWire Target Disk Mode if the other 
computer is running any version of Mac OS X or Mac OS 9 with FireWire version 2.3.3 or 
later installed. Use System Profiler (located in Applications/Utilities) to check the version 
of FireWire installed. If the other computer has an older version, check for an update at 
the Apple Service & Support website at www.apple.com/support. 

To connect your Power Mac G5 in FireWire Target Disk Mode:
1 Shut down your Power Mac G5. 

2 Use a FireWire cable with the appropriate 6- or 9-pin connector on each end to 
connect your computer to another FireWire-equipped computer.
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3 Start up your Power Mac G5 and immediately hold down the T key.

Your Power Mac G5 display shows the FireWire disk mode indicator, and the Power Mac 
G5 internal hard disk icon appears on the other computer’s desktop.

4 Drag the Power Mac G5 hard disk icon to the Trash on the other computer when you 
have finished transferring files.

5 Press the power button on the Power Mac G5 to shut it down. 

6 Disconnect the FireWire cable.

For More Information on FireWire
More information on FireWire is available on the Apple FireWire website at 
www.apple.com/firewire. You can also find information in Mac Help. Choose Help > 
Mac Help and search for “FireWire.” For information on the FireWire devices available for 
your computer, go to the Macintosh Products Guide at www.apple.com/guide. 

Using Audio Devices
Your Power Mac G5 comes with comprehensive audio capabilities, including a 
headphone jack on the front and optical digital audio out, optical digital audio in, 
analog audio line-out, and analog audio line-in ports on the back. 

Optical Digital Audio Ports
You can use a digital optical or Toslink cable to connect Digital Audio Tape (DAT) decks 
or CD players to the optical digital audio in port and input and mix your own music. 

You can also connect an audio or AV receiver to the optical digital audio out port and 
set up a Power Mac G5–based home theater system. 

Optical digital
audio in port

Optical digital
audio out port Optical digital cable

Optical digital cable

AV receiver

To speakers or
other output

CD player or other digital source
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Headphone Jack
You can plug headphones into the computer’s headphone jack. When a plug is inserted 
into this jack, your internal built-in speaker is muted.

Important:  Do not plug line-out devices into the headphone jack. Use the analog line-
out port on the back instead.

Analog Audio Ports
You can connect external microphones or other audio equipment to the analog 
minijacks on the back of the computer for line in and line out.

Use the Sound pane of System Preferences to select the audio input or output device 
you want to use.

Using Your Optical Drive
You can install or use software from CDs or DVDs using your optical drive. You can play 
multimedia on CD discs and music from audio CDs, and write music, documents, and 
other digital files to CD-R and CD-RW discs. You can also play DVD movies and use 
most DVD discs. 

If your computer has a SuperDrive, you can also burn your home movies to make video 
DVDs that can be played in most home DVD players, or you can save documents or 
other digital files to blank DVD-R, DVD-RW, DVD+R, DVD+RW, and DVD+R Double Layer 
(DL) discs using the Finder or iDVD. You can store nearly twice as much data (8.54 GB) 
on a DVD+R DL disc.

Note:  If you have older software that comes on floppy disks, contact the software 
manufacturer to see if the software is available on a CD, or purchase an external USB 
floppy disk drive for your Power Mac G5 from your Apple Authorized Reseller, an Apple 
retail store, or online from the Apple Store at www.apple.com/store.

Inserting a Disc
To install or use programs from a CD or DVD:

1 With the computer turned on, press the Media Eject (C) key on your Apple Keyboard to 
open the drive.

2 Place a disc in the tray, with the label facing up, and make sure the disc is lying flat.

3 Press the Media Eject (C) key again or gently push the tray in to close it. 

When the icon for the disc appears on the screen, the disc is ready to use.

Ejecting a Disc
You can eject a disc by dragging the disc icon to the Trash, or by pressing the Media 
Eject (C) key on your Apple Keyboard. You can also eject a disc by holding down the 
mouse button while restarting your computer.

LL3218Q87.book  Page 31  Wednesday, March 16, 2005  6:28 PM



32 Chapter 2    Using Your Computer

 

Recording Information on a CD
Your optical drive can record your favorite music, programs, and files on CD-R and 
CD-RW discs. Create your own music CDs and play them on any standard audio player. 
You can also record data files, such as applications, documents, or other digital files, on 
a recordable CD. 

With a CD-R (CD-recordable) disc, you can record information on the disc once. 
Although you can’t change the recorded information, you may be able to add more 
information until the disc is full, depending on the application you use. See the 
documentation that came with your application for specific information about 
recording on your CD-R disc. It is best to use CD-R discs for recording audio CDs, 
because your audio CD player may not read CD-RW (CD-rewritable) discs.

With a CD-RW disc, you can save and change information on your CD multiple times. 
However, some software for recording media files on CDs can record data on the disc 
only once.

To record music on a CD-R disc from your iTunes library:
1 Open iTunes (click its icon in the Dock).

2 Select the playlist you want to record.

3 Insert a blank CD-R disc.

4 Click Burn CD at the top of the iTunes window.

To record data on a CD-R disc from the Finder:
1 Insert a blank CD-R disc.

2 In the dialog that appears, enter a name for the disc and select the format you want. 
An icon for the CD appears on the desktop.

3 Double-click the CD icon, then drag files and folders to it.

4 Choose File > Burn Disc or select the disc and drag it to the Burn Disc icon in the Dock.

For information about how to use iTunes to record music files on a CD, see iTunes Help. 
Open iTunes (in Applications) and choose Help > iTunes and Music Store Help.
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Recording Information on a DVD
If you have a SuperDrive, you can record your own digital movies on a blank DVD-R, 
DVD-RW, DVD+R, DVD+RW, or DVD+R DL disc. You can also record other kinds of 
digital data (for example, you can back up your files to DVDs).

To record data to a blank DVD:
1 Insert a new blank DVD-R, DVD-RW, DVD+R, DVD+RW, or DVD+R DL disc in the drive.

2 In the dialog that appears, enter a name for the disc and select the format you want to 
create. An icon for the DVD appears on the desktop.

3 Double-click the DVD icon and drag files and folders to it.

4 Choose File > Burn Disc or select the disc and drag it to the Burn Disc icon in the Dock.

With applications such as iDVD or DVD Studio Pro, you can create your own customized 
DVD project, burn it on a blank DVD disc, and play it on most standard DVD players.

For more information about iDVD, open iDVD (in Applications) and choose Help > 
iDVD Help.
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Connecting to an Ethernet Network
Your computer comes with built-in 10/100/1000 megabit per second (Mbps) twisted-
pair Ethernet networking capability, which you can use to connect to a network or to a 
cable or digital subscriber line (DSL) modem. 

Connecting to a network gives you access to other computers. You may be able to 
store and retrieve information; use network printers and electronic mail; or connect to 
the Internet. You can also use Ethernet to share files between two computers or set up 
a small network.

If you’re connecting to an existing network, get information about the network and the 
network software you need from a network administrator who oversees its operation. 
Identify your organization’s network administrator before you begin.

Follow these guidelines when selecting a cable for your network:

Connecting to a Twisted-Pair Ethernet Network
You can connect directly to a 10/100/1000 twisted-pair Ethernet network.

Note:  You can also connect your computer to an Ethernet network that uses thin 
coaxial cables. To do this, you need an RJ-45–to–thin coax adapter (available from other 
manufacturers). See your Apple Authorized Reseller for more information on Ethernet 
media adapters.

To connect your Macintosh to a centralized 10/100/1000 twisted-pair Ethernet 
network:

1 Plug one end of an RJ-45 twisted-pair cable into the Ethernet port on your Macintosh.

Type of twisted-pair Ethernet Use twisted-pair cable types

10 Mbps Category (Cat) 3, 5, or 6

100/1000 Mbps Cat 5 or 6
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2 Plug the other end of the cord into an RJ-45 wall outlet or external Ethernet hub or 
switch that is connected to a twisted-pair Ethernet network.

After you start up the computer, you need to configure the software for your network 
connection. Your network administrator can provide the necessary information. You can 
also get help configuring your network software using Mac Help (choose Help > Mac 
Help).

To configure your network settings:
1 Choose Apple () > System Preferences and click Network.

2 Choose Built-in Ethernet from the Show pop-up menu. 

3 Click TCP/IP and enter information about your network. 

The default setting is Configure Using DHCP.

4 Click Apply Now.

For More Information on Using Ethernet
Additional information, including information about setting up an Ethernet network or 
transferring files using Ethernet, is available in Mac Help. Choose Help > Mac Help and 
search for “Ethernet” or “network.” 

For more information on networking your Power Mac G5, go to Apple Service & 
Support at www.apple.com/support.

For information on networking products you can use with your Power Mac G5, go to 
the Macintosh Products Guide at www.apple.com/guide.

RJ-45 wall plate

Twisted-pair
Ethernet cable

Ethernet hub
or switch

Ethernet port
(twisted-pair
Ethernet)
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Using Your Modem
If your Power Mac G5 came with an Apple 56K internal modem installed, plug one end 
of the modem cord or RJ-11 cable into the modem port on the back of the computer 
and the other end into a standard RJ-11 telephone wall jack.

 

Make sure you connect the internal modem to an analog phone line—the kind used 
typically in homes. The modem does not work with a digital phone line, which may 
damage the modem.

Note:  If you did not order a modem with your Power Mac G5, you can have one 
installed by an Apple Authorized Service Provider or at an Apple Retail Store. The 
Internal modem is not user-installable.

Using AirPort Wireless Networking
AirPort offers an easy and affordable way to provide wireless Internet access anywhere 
at home, at work, or in the classroom. Instead of using traditional cables, AirPort uses 
wireless local area network (LAN) technology to provide wireless communication 
between multiple computers. Through a wireless network, you can set up access to the 
Internet, transfer files, play multiplayer games, and more.

Your Power Mac G5 is AirPort-ready. The only thing you need to add is an AirPort 
Extreme Card. See “Installing an AirPort Extreme Card” on page 68. You install the 
AirPort Extreme Card in a slot inside the computer, connect it directly to the end of a 
built-in antenna cable, and install an AirPort antenna. For instructions on using your 
AirPort Extreme Card, see the About Your AirPort Extreme Card booklet that came with 
your card.

Wireless Network Connections
If you install an AirPort Extreme Card, you can:
Â Connect your computer to a computer network that has wireless access
Â Use your computer to provide network access for other computers using wireless 

cards

Modem port

Modem port icon

Warning:  Disconnect your modem from the phone jack during lightning or thunder 
storms to prevent damaging the modem with a voltage overload.
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Â Establish a wireless connection and share information with another computer that 
has an AirPort Card, an 802.11b wireless card, or an 802.11g wireless card

Check with your network administrator for more information about reaching the 
network’s wireless access point. 

If your computer comes with an AirPort Extreme Card installed or you install an AirPort 
Extreme Card, you should also connect the AirPort antenna that came with your 
computer to the AirPort antenna port (Z) on the back of the computer. See “Installing 
an AirPort Extreme Card” on page 68 for more information.

How AirPort Provides Wireless Internet Access
With AirPort, you set up a wireless connection to a device known as a base station, 
which has a physical connection to the Internet. AirPort technology works like a 
cordless telephone. The handset of the cordless phone makes a wireless connection to 
the base, which is connected to the telephone line. Similarly, your computer makes a 
wireless connection to the base station, which is connected to the telephone line or 
your Ethernet network.

Note:  The AirPort Extreme Card is compatible with all versions of the AirPort Base 
Station.

AirPort Extreme Base Station

Telephone or Ethernet connection
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Important:  Several kinds of objects placed near the computer can cause interference. 
See the instructions that come with an AirPort Extreme Card, AirPort Express, or AirPort 
Extreme Base Station to learn about avoiding interference. For more information, go to 
the Apple Service & Support website at www.apple.com/support.

For More Information on AirPort
To purchase an AirPort Extreme Card, AirPort Express, or AirPort Extreme Base Station, 
contact your Apple Authorized Reseller, visit an Apple retail store, or go online to the 
Apple Store at www.apple.com/store. 

For more information about AirPort, search for “AirPort” in Mac Help. You can also find 
information on the Apple AirPort website at www.apple.com/airport.

Using Bluetooth Wireless Technology
Your Power Mac G5 can connect to and transfer information to devices that use 
Bluetooth® wireless technology, such as Apple’s wireless keyboard and mouse, cell 
phones, Personal Digital Assistants (PDAs), and printers, eliminating the need for cables 
that traditionally connect devices together.

If your computer came with a built-in Bluetooth module, remember to connect the 
Bluetooth antenna that came with your computer to the Bluetooth antenna port (◊) on 
the back of the computer. The small cylindrical Bluetooth antenna provides reception 
for Bluetooth devices.

 

Insert the Bluetooth antenna
into the Bluetooth antenna port.
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Bluetooth wireless technology eliminates the need for many cables that traditionally 
connect devices together. Bluetooth enabled devices can connect to each other 
wirelessly at distances up to 10 meters (33 feet).

With Bluetooth wireless technology, you can do the following:
Â Use your Power Mac G5 to communicate with a Bluetooth enabled mobile phone. 

Your phone can act as a modem to connect you to a wireless service provider, at 
speeds of up to 56 kilobits per second (kbit/s), so you can use your mobile phone to 
access the Internet.

Â Exchange files between Bluetooth enabled computers and devices, even Mac to PC. 
Apple still recommends the use of AirPort Extreme wireless networking, however, for 
anything but the smallest files.

Â Synchronize data between your computer and Bluetooth enabled PDA. Using iSync, 
you can perform a hot-sync operation without cables or send your business card or 
calendar events directly to a colleague’s PDA.

Â Use a Bluetooth wireless keyboard or mouse.
Â Print to a Bluetooth printer.
Â Use a Bluetooth headset.

Setting Up a Bluetooth Device
Before you can use your mobile phone to connect to the Internet or share contact 
information, share files with other devices, or use a Bluetooth keyboard or mouse, you 
need to set up the device to work with your computer. Once you've set up the device, 
it is “paired” with your computer, and you can see it in the Devices pane of Bluetooth 
preferences. You need to pair your computer with the device only once, and they 
remain paired until you delete the paring.

To set up a Bluetooth device:
1 Choose “Set up a Bluetooth device” from the Bluetooth status menu (◊) in the menu 

bar.

2 Follow the onscreen instructions for the type of device you want to set up.

Important:  If the Bluetooth status menu is not in the menu bar, open System 
Preferences and click Bluetooth. Click Settings and then select “Show Bluetooth status 
in the menu bar.”

To delete a pairing with a device:
1 Open System Preferences and click Bluetooth. 

2 Click Devices. 

3 Select the device from the list and click Delete Pairing.
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Setting Up Bluetooth File Exchange
You can control how your computer handles files that are exchanged between 
Bluetooth devices. You can choose to accept or refuse files sent to your computer, 
which folder to use for the files you accept from other devices, which folder other 
devices can browse, and which applications to use with the files you accept.

To set up a Bluetooth file exchange:
1 Open System Preferences and click Bluetooth.

2 Click Sharing.

3 Select the On checkbox for Bluetooth File Exchange, and use the pop-up menus to 
adjust the settings.

Sending a File to a Bluetooth Device
Your computer can send files to other Bluetooth devices in range of your computer. If 
you are not paired with the device, you may have to authenticate with it before you 
can send the file. If you have already paired with the device, you may not have to 
authenticate.

To send a file to a Bluetooth device:
1 Choose Send File from the Bluetooth status menu in the menu bar.

2 Select the file you want to send and click Send.

3 Choose a device from the Device list and click Send.

If the device is not in the Device list, click Search. When the device is found, you can 
add it to your Favorites list.

For More Information on Bluetooth Wireless Technology
If your computer came with a built-in Bluetooth module, you can get help by opening 
the Bluetooth File Exchange application (located in the Utilities folder within the 
Applications folder) and choosing Help > Bluetooth Help. You can also find information 
on the Apple website at www.apple.com/bluetooth.

Note:  If you did not order a Bluetooth module with your Power Mac G5, you can have 
one installed by an Apple Authorized Service Provider or at an Apple Retail Store. 
Bluetooth modules are not user-installable. 

You can also purchase an external Bluetooth USB adapter from your Apple Authorized 
Reseller, an Apple retail store, or online from the Apple Store at www.apple.com/store.

Putting the Computer to Sleep to Save Energy
Power Mac G5 computers are set to go to sleep after a period of inactivity. Sleep is a 
state in which your computer uses very little power. You can also put the computer to 
sleep whenever you want to.
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Note:  Power Mac G5 computers are set to sleep automatically within15 minutes of 
inactivity; however, you can change the automatic sleep settings in System Preferences.

When the computer wakes from sleep, your programs, documents, and computer 
settings are exactly as you left them. To save more energy, shut down the computer 
when it’s not in use.

To put your computer to sleep, you can do any of the following:
Â Press the power button on the front of the computer.
Â Choose Apple () > Sleep.
Â Choose Apple () > System Preferences, click Energy Saver, and set a sleep timer.

When the computer is in sleep, the front panel power button light pulses.

To wake the computer, press the power button on the front of the computer or press a 
key on the keyboard. With some Apple displays, you can also use the display’s power 
button to put the computer to sleep and wake it.

Not all PCI cards or replacement AGP cards comply with the computer’s power 
management standards. If you install a noncompliant card, the computer can still enter 
sleep mode, but it may not save as much energy as possible. 

For more information about energy-saving options, see Mac Help.

Transferring Information Between Two 
Macintosh Computers
If two Macintosh computers are not connected by an Ethernet, AirPort, or Bluetooth 
network, you can transfer information between them by connecting them with a 
standard Cat 5 Ethernet cable (in effect creating a small network of just two 
computers). You can buy this type of cable from an Apple Authorized Reseller. You 
connect the cable to each computer’s Ethernet port and then turn on file sharing on 
both computers. You can also configure the Ethernet settings on two computers to 
create a small network. 

First, turn on file sharing on both computers:
1 Choose Apple () > System Preferences.

2 Click Sharing, then click Start.

Next, follow these steps on one computer:
1 Choose Go > Connect to Server.

2 Click Local Network.

3 Select the computer you want to access.

For more information about configuring Ethernet, search for “Ethernet” in Mac Help. 
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If you have an AirPort or Bluetooth wireless network, you can also transfer information 
between two Macintosh computers. For more information about AirPort or Bluetooth 
wireless networks, search for “AirPort” or “Bluetooth” in Mac Help.

You can also connect two Macintosh computers using a FireWire cable. You can then 
use FireWire Target Disk Mode to transfer files from one computer to another. For more 
information, see “FireWire Target Disk Mode” on page 29.

You can set up your computer to connect to other computers over FireWire, using the 
Internet Protocol (IP). For more information, search for “IP over FireWire” in Mac Help.

If you have an Internet connection, you can transfer files via the Internet to your .Mac 
iDisk, where you or another. Mac user can download the files.
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3 Working Inside Your Computer

You can customize and expand your Power Mac G5 to fit 
your needs. 

This chapter provides information and instructions about working inside your 
computer and includes the following procedures:
Â “Opening the Computer” on page 44
Â “Installing Memory” on page 49
Â “Installing Internal Storage Devices” on page 56
Â “Installing a PCI Expansion Card or Replacing the AGP Card” on page 64
Â “Installing an AirPort Extreme Card” on page 68
Â “Replacing the Battery” on page 69

Warning:  Apple recommends that you have an Apple-certified technician install 
memory, PCI expansion cards, and internal storage devices. Consult the service and 
support information that came with your computer for instructions on how to contact 
an Apple Authorized Service Provider or Apple for service. If you install these items 
yourself, you risk damaging your equipment, and such damage is not covered by the 
limited warranty on your computer. See an Apple Authorized Reseller or Service 
Provider for additional information about this or any other warranty question.
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Opening the Computer
1 Before you open your computer, shut it down by choosing Apple () > Shut Down.

2 Wait 5 to 10 minutes to allow the computer’s internal components to cool.

3 Touch the metal PCI access covers on the back of the computer to discharge any static 
electricity from your body.

Important:  Always discharge static before you touch any parts or install any 
components inside the computer. To avoid generating static electricity, do not walk 
around the room until you have finished installing the expansion card, memory, or 
internal storage device and closed the computer.

· Warning:  Always shut down your Power Mac G5 before opening it to avoid damaging 
its internal components or the components you want to install. Do not open the 
computer or attempt to install items inside it while it is on. 

ª Warning:  After shutting down your computer, the internal components can be very 
hot. Let the computer cool down before continuing.

Touch the metal
portion of the PCI
port access covers.
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4 Unplug all the cables and the power cord from the computer.

5 Hold the side panel and lift the latch on the back of the computer. 

· Warning:  To avoid damaging its internal components or the components you want to 
install, always unplug your Power Mac G5. Do not attempt to install items inside the 
computer while it is plugged in.

While holding the side
panel, lift the latch.
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6 Remove the side panel.

Important:  When you remove the side panel, hold it securely.

Pull the top of the side panel away from the computer,
and then lift it up and remove it from the computer.
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7 Remove the air deflector and place it on a soft, clean cloth.

Important:  Always remember to replace the air deflector after you have finished 
working inside your computer. Your computer will not function properly without the air 
deflector.

Using this finger hold,
pull the air deflector away
from the computer, and
then lift the air deflector
up and away from
the computer.
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8 Pull the front fan assembly by the handle to remove it from the computer. Set it aside. 

Note:  You do not need to remove the front fan assembly to install drives, install PCI and 
AGP cards, or replace the battery.

Pull the fan assembly
completely out of
the computer.
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Installing Memory
Depending upon the model, your Power Mac G5 has four or eight dual inline memory 
module (DIMM) slots for Double-Data-Rate (DDR) synchronous dynamic random-access 
memory (SDRAM) devices. Your computer comes with a minimum of 512 MB of random 
access memory (RAM), installed as a pair of 256 MB DIMMs in two of the DIMM slots. 
You can install additional pairs of DIMMs in the open DIMM slots on your computer’s 
main logic board.

DIMMs must be installed in equal-sized pairs and fit these specifications: 
Â 400 MHz, PC 3200 DIMMs
Â 184-pin module
Â Maximum number of memory devices on DDR SDRAM:  16
Â Nonparity
Â No error-correcting codes (NECC)
Â Unbuffered (registered or buffered DDR SDRAM cannot be used)

Important:  Memory from older Macintosh computers may not be compatible with 
your Power Mac G5. 

Note:  When purchasing DDR SDRAM for use in Macintosh computers, make sure that 
the memory vendor conforms to the JEDEC (Joint Electron Device Engineering Council) 
specification. Check with your memory vendor to ensure that the DDR SDRAM 
supports the correct timing modes and that the Serial Presence Detect (SPD) feature 
has been programmed properly, as described in the JEDEC specification. To check the 
compatibility of your DDR SDRAM DIMMs, see the Macintosh Products Guide on 
Apple’s website at www.apple.com/guide. You can purchase Apple-branded memory 
online from the Apple Store at store.apple.com.
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To install memory:
1 Open your computer and remove the side panel, air deflector, and fan assembly 

following the directions that begin on page 44.

2 Locate the DIMM slots in the computer.

Important:  Always install DIMMs in pairs of equal size and in the order designated in 
the illustration above. 

No matter how many SDRAM slots
your computer has, the SDRAM DIMMs
must be installed in pairs with one
DIMM per bank. DIMMs are already installed in these two slots.

Install additional
DIMMs in these
two slots first.

If slots are available, and you want to
install more memory, install additional DIMMs in a
similar fashion:  In pairs, one per bank, from the center outward.

Bank 1

Bank 2
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3 Open the ejectors on the DIMM slots by pushing them out to the sides.

4 Placing one hand on the back of the computer for support, align the first DIMM in the 
slot and push both ends of the DIMM down until the tabs are vertical and the ejectors 
snap into place. 

Important:  Do not touch the DIMM connectors. Handle the DIMM only by the edges.

5 Align the second DIMM in the opposite slot and push until the ejectors snap into place.

DDR SDRAM DIMM
(Your DIMM’s shape and components may vary.)

The DDR SDRAM DIMM fits into the slot only
one way. Align the notch in the DIMM with
the small rib inside the slot. With the ejectors
open (as shown), push the DIMM until it snaps
into place. The ejectors close automatically.

Connectors Notch DDR SDRAM slot

Ejectors
(They should be pushed outward to
be in the open position, as shown.) 

To make sure the DIMMs are properly seated
in their slots, place one hand behind the computer
and hold the computer so that it does not move.
With your other hand, press each DIMM
firmly into its slot.

Your computer will have either 4 or 8
DDR SDRAM slots, depending on model.

Rib (inside slot)
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6 Replace the front fan assembly by firmly pushing it back into the computer by the 
handle until it connects.

Important:  Make sure the fan assembly engages the connector or your computer will 
not operate properly. Gently pull the fan assembly to see if it is properly connected. If it 
resists and stays in place, it is connected.

Slide the plastic rail on the fan assembly
into the cutout in the sheet metal divider
inside the computer. The fan assembly
needs to engage this connector.

LL3218Q87.book  Page 52  Wednesday, March 16, 2005  6:28 PM



Chapter 3    Working Inside Your Computer 53

 

7 Replace the air deflector. 

Important:  Always remember to replace the air deflector. Your computer will not 
function properly if the air deflector is not in place.

Slide the three tabs on the air deflector into the slots
in the computer and then push the air deflector closed.
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8 Replace the side panel.

Important:  Always replace the side panel before you start up your computer. Your 
computer does not function properly if the side panel is not in place.

Place the side panel into the slot in the computer
and then push the side panel closed.
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9 Push the latch down to close and secure the side panel.

Important:  When you replace the side panel, hold it securely so that it stays in place as 
you push the latch down.

While pushing the side panel against
the computer, push the latch down
until it is firmly secured against the
back of the computer.

To lock the side panel or secure the
computer, flip down the lock tab
before you close the latch. This
provides a metal loop through
which you can attach a lock or cable.
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Installing Internal Storage Devices
Your Macintosh has three internal drive bays:  one optical drive bay and two hard drive 
bays. In most configurations, a single hard disk drive occupies the top hard drive bay 
and an optical drive is located in the front optical drive bay. 

You can add a Serial ATA disk drive to the empty slot in the hard disk drive bay. The 
drives must meet these specifications:
Â Type:  Serial ATA
Â Width:  3.9 inches (102 mm)
Â Depth:  5.7 inches (147 mm)
Â Height:  1.0 inch 

Important:  Use the original Apple cables that came with your Macintosh when you 
install ATA or optical drives. 

For more information about requirements and devices supported, see your 
Apple Authorized Reseller and the support section of the Apple website at 
www.apple.com/support.
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Installing Serial ATA Drives
Your Macintosh can accommodate one additional internal 1-inch-high Serial ATA drive 
in the hard drive bay, for a total of two drives. Your computer comes with one Serial 
ATA drive installed, and it usually sits in the top hard drive bay. You can install a second 
Serial ATA drive in the lower hard drive bay.

1 Open your computer and remove the side panel following the directions that begin on 
page 44.

2 Unscrew the four drive guides from the left side of the hard drive bay and screw them 
to the threads at the sides of the hard drive as illustrated above.

Important:  If the printed circuit board (PCB) is exposed on the bottom of the hard disk 
drive, hold the drive by its sides. To avoid damaging the drive, take care not to touch 
the PCB during installation.

Install the four drive guides into four of the
threaded holes on the side of the drive. If you
have a choice, use holes that are closest to
the corners of the drive.

Your drive will need to have these
blade-type connectors to attach
the power and data cables.

Some drives may have these
pin-type connectors, too, but
you won’t be connecting any
cables to them.

The four drive guides are
stored in the plastic divider
next to the hard drive bays.
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3 To install an additional drive, slide the drive into the lower drive bay, align the drive 
guides into the bottom track, and gently push the drive until it snaps into place.

4 To replace the drive in the top drive bay, pull the original drive out of the drive bay and 
drop it down slightly until it clears the drive bay. Slide the replacement drive into the 
top drive bay, aligning the front drive guides into the middle track. Engage the rear 
drive guides in the top track as the drive moves into the drive bay. Gently push the 
drive into the bay until it snaps into place.

Note:  If a hard drive is installed in the lower drive bay, remove it before replacing the 
hard drive in the top drive bay.

Engage the drive guides in the bottom track in the lower
drive bay and slide the drive in until it stops.

Drive guides

To install a replacement drive in the top drive bay, engage
the front drive guides in the middle track and push the drive
in. Engage the rear drive guides in the top track as the drive
moves upward into the bay. Slide the drive in until it stops
and secure it with the top drive bay tab.

Drive guides

Connect the power cable and the
smaller data cable to the hard disk drive. 
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5 Pull the appropriate drive bay tab down to secure the drive.

6 Connect the power cable and the Serial ATA data cable to the drive.

7 Replace the side panel, following the directions that begin on page 54.

Secure the drive in position by rotating the drive
bay tab to its closed (horizontal) position.

Connect the power cable and the data
cable to the hard disk drive. 
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Replacing the Optical Drive
Your computer comes with an optical drive installed, either a SuperDrive or Combo 
drive. Follow these instructions to replace the optical drive in the optical drive bay. 

Important:  Contact your drive manufacturer or consult the manufacturer’s website to 
determine if your drive is set for cable select mode. Before installation, set the drive to 
cable select if the manufacturer hasn’t already done so.

1 Open your computer and remove the side panel following the directions that begin on 
page 44.

2 Disconnect the optical drive ribbon cable from the logic board.

3 Push the optical drive release levers out to release the drive.

Disconnect this cable from the main logic board in
preparation for removing the optical drive.

Swing open the two optical drive release levers.
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4 Carefully pull the drive a short distance out of the bay. 

5 Disconnect the ribbon cable from the back of the original drive and gently pull the 
cable through the opening in the sheet metal divider at the back of the optical drive 
bay. 

6 Place two or three fingers through the opening at the back of the optical drive bay and 
push the drive out slightly so you can remove it from the computer.

7 Remove the power cable from the drive.

8 Unscrew the four optical drive guide pins from the bottom of the original drive and 
attach them to the bottom of the replacement drive.

9 Remove the metal shield from the front of the drive and attach it to the front of the 
replacement drive.

Remove the metal shield
from the optical drive.

Remove the four metal
optical drive guide pins
from the bottom of the drive.

Remove the power
cable from the back
of the optical drive.

Remove the drive from the bay by inserting
a couple of fingers through the ribbon cable
opening and pushing against the drive.

Remove the ribbon cable from the back of
the optical drive. Slide the other end of the
ribbon cable up through the opening  in the
sheet metal divider inside the computer.
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10 Carefully remove the ribbon cable from the top of the original drive and transfer it to 
the replacement drive.

Important:  Reusable adhesive tape on the underside of the ribbon cable attaches the 
cable to the drive. When removing the cable from the original drive, be careful to keep 
the tape with the cable.

11 Attach the ribbon cable connector and the power cable to the back of the replacement 
drive.

12 Insert the drive part way into the drive bay and bend the free end of the ribbon cable, 
then pull it down through the opening in the sheet metal divider at the back of the 
optical drive bay.

Install the metal shield
on the optical drive.

Install the four metal optical drive guide
pins into the bottom of the drive.

Attach the power cable to
the back of the optical drive.

Attach the ribbon cable to the back of the
optical drive. Slide the other end of the
ribbon cable down through the opening in
the sheet metal divider inside the computer.
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13 Slide the drive the rest of the way into the drive bay, aligning the optical drive guide 
pins in the slots, and gently push the drive into place.

14 The optical drive release levers should close when the drive is installed correctly. If they 
don’t close, gently push them. 

15 Attach the optical drive ribbon cable to its connector on the logic board. 

16 Replace the side panel, following the directions that begin on page 54.

Push the optical drive into the computer so
that the guide pins on the bottom of the drive
engage the four slots inside the computer.
Close the optical drive release levers completely
when the drive is properly seated.

Reattach this cable to the connector
on the main logic board.
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Installing a PCI Expansion Card or Replacing 
the AGP Card
You can expand the capabilities of your Power Mac G5 by installing cards in its 
expansion slots. Your Power Mac G5 has four expansion card slots, three of which 
accommodate Peripheral Component Interconnect (PCI) cards and one that accepts an 
advanced graphics port (AGP) card.

AGP cards and PCI cards have different connectors, so you cannot insert a PCI card into 
the AGP slot.

About AGP Cards
Your AGP card, installed in slot 1, contains the graphics processor unit (GPU) and 
provides the computer’s display ports. Slot 1 is designed specifically to accept AGP 
cards. This 533-megahertz (MHz) slot accommodates 1.5-volt (V) AGP cards (see the 
illustration on page 67).

You can replace the card that came with the computer with an AGP 8X or AGP 8X Pro 
card. A replacement AGP card must have driver software compatible with Mac OS X.

About PCI Expansion Cards
Your Macintosh has three expansion slots, labeled 2, 3, and 4, which can accommodate 
expansion cards up to 12 inches long. Depending upon the model of your Power Mac 
G5, you can install either PCI or PCI-X cards. 

Maximum power consumption for all four expansion slots (the three PCI expansion 
cards and the AGP card) should not exceed 90 watts (W). 

Card type supported Slot Card speed

PCI1 slots 2, 3, and 4 64-bit, 33 MHz

PCI-X slots 2 and 3 64-bit, 100 MHz 

PCI-X slot 4 64-bit, 133 MHz

1 The PCI slots can accommodate mixed-voltage (5.0 V, 12 V, or 3.3 V) cards, but only at 3.3 V signaling, with 32-bit or 
64-bit data widths and a 33 MHz frequency. You can add a 66 MHz card to a 33 MHz PCI slot if the card can operate 
at the lower 33 MHz rate.

Warning:  Do not use PCI cards that function only at 66 MHz in the 33 MHz PCI slots. 
Damage to your equipment could result. If you have a 66 MHz PCI card, check with 
the card’s manufacturer to see if it also works at 33 MHz.
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To determine whether your computer has PCI or PCI-X slots, read the ID label, which is 
located on the side of the computer at the bottom under the air deflector. You can also 
identify your model by the number of DIMM slots. Computers with 4 DIMM slots have 
33 MHz PCI slots; computers with 8 DIMM slots have 100 and 133 MHz PCI-X slots.

Your computer’s ID label
tells you what hardware
configuration you have.
It is coded and resembles
the label shown here. If
your computer has PCI-X
slots it will be listed here.
If you don’t see “PCI-X”
your computer has
PCI slots.
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Installing Your Card
You can install an AGP card in slot 1 only. The AGP slot accepts standard AGP cards or 
AGP Pro cards. Install either PCI or PCI-X cards in the slots labeled PCI 2, 3, and 4. See 
the table on page 64.

1 Open your computer and remove the side panel and air deflector following the 
directions on page 44.

2 Remove the screw in the port access cover, pull out the access cover, and set it aside.

Note:  To prevent screws from the PCI port access cover from dropping into the 
enclosure, you may want to use a magnetic screw driver, available at most electronic 
supply stores. Take care not to place the magnetic screw driver near your hard drives or 
media such as CDs or DVDs.

3 Remove the card that you want to install from its static-proof bag and hold it by its 
corners, taking care not to touch the gold connector or any of the components on 
the card.

· Warning:  To avoid damaging its internal components or the components you want to 
install, always turn off and then unplug your Power Mac G5. Wait 5 or 10 minutes for it 
to cool down. Do not attempt to install items inside it while it is plugged in.

Port access cover

Remove the screw that
holds the port access
cover in place.

If you need to remove
the card in the AGP slot,
lift up on this tab to
release the catch.
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4 Align the card’s connector with the expansion slot and press until the connector is 
inserted all the way into the slot.

If you’re installing a 12-inch card, make sure the card engages the appropriate guide.

Press the card gently but firmly until the connector is fully inserted.
Â Don’t rock the card from side to side; instead, press the card straight into the slot. 
Â Don’t force the card. If you meet a lot of resistance, pull the card out. Check the 

connector and the slot for damage or obstructions, then try inserting the card again.
Â Pull the card gently to see if it is properly connected. If it resists and stays in place, 

and if its gold connectors are barely visible, the card is connected. 

5 Reinsert the port access cover screw and tighten it to hold the card in place.

6 Replace the air deflector and side panel, following the directions that begin on 
page 53.

Port access opening

PCI slot

Reinstall the screw
to secure the card
in place.

If the PCI card you are
installing is full-length
(12 inches), make sure
it fits in one of these
card guides.

Warning:  If you remove a card from your computer and do not install a replacement, 
be sure to place a port access cover over the empty slot. Covers keep foreign objects 
out of the enclosure. An uncovered slot can affect the airflow that cools the 
computer’s internal components and cause damage.
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Installing an AirPort Extreme Card
AirPort offers an affordable and easy way to provide wireless Internet access anywhere 
in the home, at work, or in the classroom. You can install anAirPort Extreme Card in 
your Power Mac G5.

Important:  You must install an AirPort Extreme Card. Older AirPort Cards will not work 
in the Power Mac G5.

1 Open your computer following the directions on page 44.

2 Position the AirPort Extreme Card with the Apple logo facing up, insert the card into 
the card slot, and press it firmly into the connector.

3 Carefully connect the coaxial antenna wire to the port on the end of the AirPort 
Extreme Card.

With the Apple logo
facing up, insert the
AirPort Extreme Card
into the card slot. Press
the card firmly into the
connector.

Plug the antenna wire into
the hole in the end of the
AirPort Extreme Card.

The AirPort Extreme Card
slot is located underneath
the sheet metal divider.

The AirPort Extreme Card
antenna wire is stowed
underneath the sheet metal
divider with a clip. Remove
the wire from the clip before
attaching it to the card.
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4 Replace the front fan assembly, air deflector, and side panel, following the directions 
that begin on page 52.

5 Attach the AirPort Extreme antenna to the AirPort antenna port (Z) on the back panel. 
To adjust reception, you can rotate the antenna.

 

Replacing the Battery
Your computer has a 3.6 V lithium battery on the main logic board. If your computer 
has intermittent problems starting up or random changes in its date and time settings, 
you may need to replace the battery. Purchase a replacement battery from an Apple 
Authorized Reseller.

Important:  Batteries contain chemicals, some of which may be harmful to the 
environment. Please dispose of used batteries according to your local environmental 
laws and guidelines.

Warning:  The FCC Rules require that the operator or a nearby person be more than 
1 centimeter (0.4 inches) away from the AirPort Extreme antenna during transmission. 
In addition, the AirPort Extreme antenna must not be co-located with any other 
transmitter or antenna except for the Apple Bluetooth antenna model A1067.

Install the AirPort antenna
into the AirPort antenna port.
You can rotate the antenna
through a full 360°.
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To replace the battery:
1 Open your computer following the directions on page 44.

2 If a PCI card is installed next to the battery, remove the card.

3 Remove the battery from its holder, noting the orientation of the battery’s positive end. 
(A plus sign is marked on or near the battery holder.)

If necessary, spread the tabs holding the battery so you can remove it. Spread the tabs 
gently so they don’t break.

4 Insert the new battery in the holder, making sure the battery’s positive symbol aligns 
with the positive symbol on or near the holder.

5 Replace the air deflector and side panel, following the directions that begin on 
page 53.

Remove the battery by
pulling it out of its holder.
You may need to spread
the two tabs to release
the battery.

· Warning:  Installing the battery incorrectly may cause an explosion. Be sure the 
battery’s positive and negative poles are correctly oriented in the holder. Use only the 
same type of battery or an equivalent recommended by the manufacturer of the 
original.
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4 Troubleshooting 

If you have a problem while working with your computer, 
here are some things you can try right away. 

The computer won’t respond or the pointer won’t move.
First, make sure the mouse and keyboard are connected.
Â Unplug and then plug in the connectors and make sure they are firmly seated.

Then try to cancel what the computer is doing.
Â Press the Command (x) and Q keys at the same time to try to quit the current 

application. 
Â Press the Command (x) and period keys at the same time. If a dialog appears, click 

Cancel. 
Â In Mac OS X, choose Apple () > Force Quit and select the application you would like 

to quit. Restart the computer by choosing Apple () > Restart to be sure the 
problem is entirely cleared up. You can also force quit by pressing the Esc, Option, 
and Command (x) keys at the same time.

Â In Classic, hold down the Esc, Option, and Command (x) keys at the same time to 
force an application to quit. 
Â If that doesn’t work, hold down the power button on the front of the computer for 

5 seconds. After the computer turns off, press the button again to turn it on.
Â If all else fails, unplug the power cord to turn the computer off, then plug in the 

power cord and use the front panel power button to restart the computer.
Â If the problem occurs only when you use a particular program, check with the program’s 

manufacturer to see if it is compatible with your computer.
Â If the problem occurs frequently, choose Help > Mac Help. 

Â In Mac OS X, search for “solve problems.”
Â In Classic, look at the section on how to prevent and solve problems. You may also 

need to check for extension conflicts.

LL3218Q87.book  Page 71  Wednesday, March 16, 2005  6:28 PM



72 Chapter 4    Troubleshooting

 

The computer won’t turn on or start up.
Â Make sure the power cord is connected to a working power source. The plug on the 

power cord must be completely inserted into the computer’s power socket and 
firmly seated for your computer to operate correctly.

Â If your computer still does not start, try resetting the parameter random access 
memory (PRAM). Turn on the computer and immediately hold down the Command 
(x), Option, P, and R keys until you hear the startup sound a second time. Release 
the keys. Set your hard disk as the computer’s startup disk, by doing the following: 

1 Choose Apple () > System Preferences 

2 Click Startup Disk

3 Select your hard disk

The PRAM is reset to the default values and your clock settings may need to be reset.
Â If your computer does not start up after resetting the PRAM, restart your computer 

while holding down the Option key to select your startup system. 
Â If this doesn't work, restart your computer while holding down the Shift key. 

The status light flashes and the computer won’t start up.
Â If you recently installed additional memory, a PCI expansion card, or another internal 

component, make sure that it is correctly installed and that it is compatible with your 
computer. See if removing it allows the computer to start up.

Â If the status light still flashes, determine the number of flashes to identify the 
problem:
Â 2 flashes:  no RAM installed
Â 3 flashes:  incompatible RAM installed
Â 4 flashes:  no good DIMM banks
Â 5 or 6 flashes:  contact an Apple Authorized Service Provider

You are unable to eject a disc.
A file on the disc may be in use. Quit applications that are open, then try again.

If that doesn’t work, choose Apple () > Restart and hold down either the mouse 
button or the Media Eject (C) key on your Apple Keyboard.

If that doesn’t work:
1 Shut down the computer.

2 Carefully press down the front panel covering the front of the drive tray and locate the 
small hole below the drive tray.

3 Carefully insert the end of a large straightened paper clip into the hole.

4 Push firmly until the tray opens.

5 Pull out the tray, remove the disc, and push the tray to close it.

LL3218Q87.book  Page 72  Wednesday, March 16, 2005  6:28 PM



Chapter 4    Troubleshooting 73

 

Software Problems
Important:  To use Mac OS 9 applications with your computer, you must install 
Mac OS 9 (see “Installing Mac OS 9” on page 77). To start the Classic environment, open 
a Mac OS 9 application or double-click a document that requires a Mac OS 9 
application. Classic works in the background to access Mac OS 9 features and software 
applications.

You have a problem with a software program.
Â Use Software Update to ensure that you have the latest drivers, bug fixes, and other 

updates.
Â For problems with software from a manufacturer other than Apple, contact the 

manufacturer.

You have a problem using your computer or working with Mac OS X.
Â Look in Mac OS Help (in the Help menu) for instructions and troubleshooting 

information.
Â Go to the Apple Support website on the Internet for the latest troubleshooting 

information and software updates:  www.apple.com/support.

You have trouble using AirPort wireless communication.
Â Make sure you have properly configured the software according to the instructions 

that came with your AirPort Extreme Card, AirPort Express, or AirPort Base Station.
Â Make sure the computer or network you are trying to connect to is running and has 

a wireless access point.
Â Make sure you are within antenna range of the other computer or the network’s 

access point. Nearby electronic devices or metal structures can interfere with wireless 
communication and reduce this range. Repositioning or rotating the computer may 
improve reception.

Â Check the AirPort signal level. You may have up to four bars in the AirPort status icon 
in the menu bar.

Â For more information, see the instructions that came with the wireless device or 
search for “AirPort” in Mac Help.
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Problems With Your Display

No image appears on the screen.
Â Make sure the display and computer are turned on.
Â Make sure the cables are connected properly to your computer and the display.
Â Make sure your computer is not in sleep. Press the power button or any key to see if 

the computer wakes. 
Â Make sure the display brightness and contrast are set properly. Some displays have 

brightness and contrast controls on or under their front edges.
Â Reset the PRAM by restarting the computer while holding down the Command (x), 

Option, P, and R keys until you hear the startup sound a second time. Then start up 
using the software installer disc that came with your computer.

The screen image appears dim or flickers.
Â Adjust the display brightness and contrast settings. Some displays have brightness 

and contrast controls on or under their front edges. Depending on how dim your 
display appears, you may be able to adjust brightness or contrast using the Displays 
pane of System Preferences.

Â Calibrate the display by choosing Apple () > System Preferences. Click Displays, 
select Color, and click Calibrate.

Â The flickering may be caused by interference from a nearby power line, a fluorescent 
light, or an electrical device—for example, a radio, a microwave oven, or another 
computer. Try relocating nearby electrical devices or moving your computer and 
display.

No colors appear on the screen or the colors don’t look right.
Â Make sure the display is connected firmly to the computer.
Â Calibrate your display, as described previously. For more information on color and 

your display, see Mac Help.
Â Open the Displays pane of System Preferences and make sure your display is set to 

display colors. For more information on color and your display, see Mac Help.

After you change the screen resolution, desktop icons move.
Changing the screen resolution affects the display of information on your screen. 
The operating system may reposition icons after you change the screen resolution.

Warning:   If you have a problem with your Apple display and nothing presented in 
this manual solves it, contact an Apple Authorized Service Provider or Apple for 
assistance. If you attempt to repair the display yourself, any damage you may cause to 
the display will not be covered by the limited warranty on your display. Contact an 
Apple Authorized Reseller or Service Provider for additional information about this or 
any other warranty question.
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The screen freezes.
Â Force the application that has frozen to quit. Choose Apple () > Force Quit and 

select the application.
Â If that doesn’t work, force the computer to restart by pressing the power button on 

the front of your computer for approximately 5 seconds. 

The light on the front of the display is flashing.
On some Apple flat-panel displays, the power light displays a series of short flashes 
when an error has been detected. 
Â If you see a repeating sequence of three short flashes, the display is detecting input in 

the wrong video format. Make sure your display is compatible with your graphics 
card and that you’ve installed the correct display software, if your display came with 
installation software. 

Â If you see a sequence of two short flashes and a long flash, the display is detecting a 
problem with a backlighting lamp. Contact an Apple Authorized Reseller or Service 
Provider. 

Using Apple Hardware Test
You can use Apple Hardware Test to help determine if there is a problem with your 
computer’s hardware. 

To use Apple Hardware Test:
1 Disconnect all external devices from your computer except the keyboard and mouse. 

If you have an Ethernet cable connected, disconnect it.

2 Insert the Mac OS X Install Disc 1 that came with your computer. 

3 Restart your computer and hold down the Option key as it starts up. 

A list of available startup volumes appears. 

4 Click Apple Hardware Test and click the right arrow.

5 Follow the onscreen instructions when the Apple Hardware Test main screen appears 
(after about 45 seconds).

6 Make a note of the error code before pursuing support options.

If Apple Hardware Test detects a problem, it displays an error code. If Apple Hardware 
Test does not detect a hardware failure, the problem may be software-related.

For more information about Apple Hardware Test, see the Apple Hardware Test Read 
Me file on Mac OS X Install Disc 1. 
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Reinstalling the Software That Came With Your Computer
Use the software install discs that came with your computer to reinstall Mac OS X and 
the applications that came with your computer, and to install Mac OS 9.

Important:  Apple recommends that you back up the data on your hard disk before 
restoring software. Apple is not responsible for any lost data.

Installing Mac OS X
To install Mac OS X:

1 Back up your important files, if possible.

2 Insert the Mac OS X Install Disc 1 that came with your computer.

3 Double-click “Install Mac OS X and Bundled Software.”

4 Follow the onscreen instructions.

5 Select the destination disk for installation and continue following the onscreen 
instructions. 

Your computer may restart and ask you to insert the next Mac OS X install disc.

Important:  Because the “Erase and Install” option erases your destination disk, you 
should back up your essential files before installing Mac OS X and other applications.

Installing Applications
To install the applications that came with your computer, follow the steps below. Your 
computer must have Mac OS X already installed. 

1 Back up your important files, if possible.

2 Insert the Mac OS X Install Disc 1 that came with your computer.

3 Double-click “Bundled Software.”

4 Follow the onscreen instructions.

5 Select the destination disk for installation and continue following the onscreen 
instructions. 

To install iCal, iChat, iSync, iTunes, and Safari, follow the “Installing Mac OS X” 
instructions above.
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Installing Mac OS 9
Your computer does not come with Mac OS 9 installed. To use Mac OS 9 applications 
with your computer, you have to install Mac OS 9 using the Mac OS X Install Disc 2.

To install Mac OS 9: 
1 Back up your important files, if possible.

2 Insert the Mac OS X Install Disc 2 that came with your computer.

3 Double-click “Install Mac OS 9 System Support.”

4 Follow the onscreen instructions.

5 Select the destination disk for installation and continue following the onscreen 
instructions. 

Maximizing Ethernet Performance
Your computer performs best when the Ethernet port to which it is connected is set to 
auto-negotiate. Ask your network administrator to verify this setting. 

Important:  If you experience connection problems on your network, make sure your 
network switch is set to auto-negotiate, if possible. If a switch’s port is not auto-
negotiating, your computer detects the appropriate speed but defaults to half-duplex 
mode. If the switch’s port at the other end of the link is configured for full-duplex 
mode, a large number of late events can occur on the link. If it isn’t possible to set the 
switch to auto-negotiate, then set the switch’s port to half-duplex. For more 
information, see the documentation that came with the Ethernet switch.

Note:  If you connect your computer directly to a configurable Ethernet switch, have 
your network administrator disable spanning tree on that port. Otherwise your 
computer may duplicate the AppleTalk address of another computer on the same 
network and both network connections may become unreliable.

Locating Your Product Serial Number
System Profiler shows the serial number of your computer. Open System Profiler (in 
Applications/Utilities) and click the System Profile tab.

The serial number of your Power Mac G5 is also on the configuration label, which is 
located inside the side panel, directly below the air deflector. 
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A Specifications

Processor and Memory Specifications 
Processor
Â PowerPC processor with 512 kilobytes (KB) of on-chip L2 cache per processor

Random-access memory (RAM)
Â Double-Data-Rate (DDR) synchronous dynamic random-access memory (SDRAM)
Â All DDR SDRAM supplied in removable dual inline memory modules (DIMMs)
Â DIMMs installed in pairs of equal size
Â Four or eight DIMM slots available for 400 MHz, PC 3200 DDR SDRAM, depending on 

your computer model
256 MB DIMMs must have 128 or 256 megabit (Mbit) technology devices; 
512 MB DIMMs must have 256 Mbit technology devices; and 1 GB DIMMs 
must have 512 Mbit technology devices.

Â 2.5 volt (V) unbuffered
Â 184-pin
Â No error-correcting codes (NECC)
Â Nonparity

System Profiler, located in Applications/Utilities, provides information about your 
computer, including the amount of memory.

Graphics Controller
Â AGP 8X Pro graphics card with two Digital Visual Interface (DVI) connectors. AGP 3.0 

or AGP Pro compliant.

Video Display Modes
For technical specifications for your display:
Â Apple displays:  Go to the Apple website and check the specifications for your product 

at www.apple.com/displays.
Â Non-Apple displays:  Go to www.apple.com/guide.
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Combo Drive (DVD-ROM/CD-RW) Specifications
Â Disc diameters supported:  12 cm and 8 cm 

Data formats
Â CD-ROM
Â CD-Audio
Â CD-R
Â CD-RW
Â CD-I
Â CD-I Bridge
Â CD Extended
Â CD Mixed Mode
Â Photo CD
Â Video CD
Â Enhanced CD
Â DVD-Video
Â DVD-ROM
Â DVD-R (read only)

SuperDrive (DVD-R/CD-RW) Specifications
Â Disc diameters supported:  12 cm and 8 cm 

Data formats
Â CD-ROM
Â CD-Audio
Â CD-R
Â CD-RW
Â CD-I
Â CD-I Bridge
Â CD Extended
Â CD Mixed Mode
Â Photo CD
Â Video CD
Â Enhanced CD
Â DVD-Video
Â DVD±R
Â DVD±RW
Â DVD+R DL
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USB Specifications 
Â Support for Universal Serial Bus (USB) 2.0 and 1.1
Â Five external USB Type A ports

Â One USB 2.0 port on the front 
Â Two USB 2.0 ports on the back
Â Two USB 1.1 ports on the Apple Keyboard

Â Each rear port is on a separate 480 megabit-per-second (Mbps) USB channel
Â 500 milliamperes (mA) at 5 V are available for each USB 2.0 port, for a total of 

1.5 amperes

FireWire Specifications 
Â Support for FireWire 400 and FireWire 800
Â Three external FireWire ports

Â One FireWire 400 port on the front
Â One FireWire 400 and one FireWire 800 port on the back

Â Data transfer speed:
Â FireWire 400:  100, 200, and 400 Mbps
Â FireWire 800:  100, 200, 400, and 800 Mbps

Power
Â Output voltage:  Approximately 13 to 25 V
Â Output power:  Up to 15 W

Ethernet Specifications 
Â IEEE 802.3 compliant
Â Maximum cable length:  100 meters (m)
Â Protocols:  Open Transport, AppleShare, AppleTalk, NetWare for Macintosh, TCP/IP
Â Connector:  RJ-45 for 10Base-T, 100Base-TX, and 1000Base-T
Â Media, 10Base-T:  Category 3 or higher UTP on 2 pairs up to 100 m
Â Media, 100Base-TX:  Category 5 UTP on 2 pairs up to 100 m
Â Media, 1000Base-T:  Category 5 and 6 UTP on 4 pairs up to 100 m
Â Channel speeds:  IEEE Auto Negotiation of 10Base-T, 100Base-TX, and 1000Base-T

Modem Specifications
Â Data communications standard:  K56Flex and V.92
Â Speed:  53 kilobits per second (Kbps)
Â Fax standard:  ITU V.17
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Bluetooth Specifications (Optional)
Â Wireless data rate:  Up to 3 Mbps
Â Range:  Up to 10 meters or 33 feet (data rates may vary depending on environmental 

conditions)
Â Frequency band:  2.4 gigahertz (GHz)

AirPort Extreme Card (Optional) Specifications
Â Wireless data rate:  Up to 54 Mbps
Â Range:  Up to 150 feet (data rates may vary depending on environmental conditions)
Â Frequency band:  2.4 gigahertz (GHz)
Â Radio output power:  15 dBm (nominal)

Compatibility
Â 802.11 Direct Sequence Spread Spectrum (DSSS) 1 and 2 Mbps standard
Â 802.11b 11Mbps standard
Â 802.11g 54 Mbps standard

Optical Digital Audio Specifications 
Â Data format:  Sony/Phillips Digital Interface (S/PDIF) protocol (IEC60958-3)
Â Connector type:  Toslink optical (IEC60874-17)
Â Bits per sample:  16-bit or 24-bit

Optical digital audio out 
Based on a typical situation with playback of a 1KHz, -1dBFS 24-bit sine wave, 44.1Khz 
output sample rate, unless otherwise specified below.
Â Output sample rate:  32 kHz, 44.1 kHz or 48 kHz
Â Signal-to-noise ratio:  Greater than130 dB
Â Total harmonic distortion + noise:  Less than -130 dB (0.00001 percent)

Optical digital audio in 
Based on a typical situation with playback of a1KHz, -1dBFS 24-bit sine wave, unless 
otherwise specified below.
Â Fsi–input sample rate (external clock mode):  32 kHz, 44.1 kHz or 48 kHz
Â Fsi–input sample rate (internal clock mode):  16 kHz to 96 kHz
Â Signal-to-noise ratio (external clock mode):  Greater than130 dB
Â Signal-to-noise ratio (internal clock mode, 16 kHz < Fsi < 96 kHz):  Less than -112 dB
Â Total harmonic distortion + noise (external clock mode):  Less than -130 dB (0.00001%)
Â Total harmonic distortion + noise (internal clock mode, 16 kHz < Fsi < 96 kHz):  Less than 

-112 dB (0.0003%)
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Analog Audio Specifications
Â Sample rate:  32 kHz, 44.1 kHz or 48 kHz
Â Jack type:  1/8” mini
Â Bits per sample:  16-bit or 24-bit
Â Frequency response:  20 Hz to -20 kHz, +0.5 dB/-3 dB 

Sound out using the headphone jack
Â Output voltage:  1.4 volts (root mean square) (Vrms) (+4 dBµ)
Â Output impedance:   24 ohms
Â Output power:  20 milliwatts (mW)
Â Signal-to-noise ratio:  Greater than 90 dB
Â Total harmonic distortion:  Less than -80 dB (0.01 percent)
Â Channel separation:  Greater than 65 dB

Analog audio line-in
Â Maximum input voltage:  2 Vrms (+8 dBµ)
Â Input impedance:  Greater than 47 kilohms
Â Signal-to-noise ratio:  Greater than 90 dB
Â Total harmonic distortion:  Less than -85 dB (0.006 percent)
Â Channel separation:  Greater than 75 dB

Analog audio line-out 
Â Output voltage:  1.4 Vrms (+4 dBµ)
Â Output impedance:   24 ohms
Â Signal-to-noise ratio:  Greater than 90 dB
Â Total harmonic distortion:  Less than -80 dB (0.01 percent)
Â Channel separation:  Greater than 65 dB

Power Supply 
AC line input
Â Voltage range:  100–240 V alternating current (AC)
Â Current:   7.5 amperes (A) or 9.5 amperes (A)
Â Frequency:  50–60 Hz

DC display output
Â Dependent on video card

LL3218Q87.book  Page 83  Wednesday, March 16, 2005  6:28 PM



84 Appendix A    Specifications

 

Power Requirements for Devices You Can Connect
Expansion cards
Â Combined maximum power available for the AGP and PCI cards is 90 W.

USB devices
Â Each of the computer’s built-in USB ports is allotted 500 mA. 

FireWire devices
Â The computer can provide up to 15 W total to the FireWire ports.

System Clock and Battery 
Â CMOS custom circuitry with long-life lithium battery. You can replace the computer’s 

battery (see “Replacing the Battery” on page 69) with a new one purchased from an 
Apple Authorized Reseller.

Dimensions and Operating Environment
Dimensions
Â Weight:  17.84 kg (39.32 lbs.)

Weight depends on configuration. The weight above is for a basic configuration and 
may be greater if optional devices are installed.

Â Height:  511 mm (20.12 in.)
Â Width:  206 mm (8.11 in.)
Â Depth:  475 mm (18.70 in.)

Operating environment
Â Operating temperature:  10° to 35° C (50° to 95° F)
Â Storage temperature:  –40° to 47° C (–40° to 116° F)
Â Relative humidity:  5% to 95% (noncondensing)
Â Altitude:  0 to 3048 meters (0 to 10,000 feet)
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B Safety, Maintenance, 
and Ergonomics

This appendix provides important information about 
safety procedures, routine maintenance, and ergonomic 
considerations for using your computer and display.

Important Safety Information
The only way to disconnect power completely from your computer is to unplug the 
power cord from the main power supply. To disconnect your display completely, you 
must also unplug its power cable from the computer or power outlet. Make sure that at 
least one end of the device’s power cord is within easy reach so that you can unplug 
the computer or display when necessary.

For your own safety and that of your equipment, always take the following 
precautions.
Disconnect the power plug (by pulling the plug, not the cord), from your computer or 
display and disconnect the phone cord if any of the following conditions exists:
Â The power cord or plug becomes frayed or otherwise damaged
Â You spill something into the case
Â Your computer or display is exposed to rain or any other excess moisture
Â Your computer or display has been dropped or the case has been otherwise 

damaged
Â You suspect that your computer or display needs service or repair
Â You want to clean the computer or display case or screen 
Â You notice a coolant leak in or from your computer (for Power Mac G5 models 

equipped with a liquid cooling system)
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Â If you plan to store your computer for an extended period of time, remove the 
battery.

Liquid Cooling System
Some Power Mac G5 models use a liquid cooling system to manage the temperature in 
the computer. The liquid cooling system is sealed and is designed to be opened only 
by an Apple Authorized Service Provider (AASP).

· Warning:  To prevent accidents and damage to your computer or display, be sure that 
you always follow these instructions:

Â Keep your computer and display away from sources of liquids and moisture.
Â Don’t set anything on top of the computer or display.
Â Keep the computer and display vents free from obstruction.
Â Never remove the case from the display or open your computer when it’s running. 

You could come in contact with hazardous voltage.
Â During lightning storms, disconnect your modem from the phone jack to prevent 

damaging the modem with a destructive voltage overload.

Your Macintosh is equipped with a three-wire grounding plug—a plug that has a 
third grounding pin. This is a safety feature. Don’t modify the plug to fit into an 
ungrounded outlet. Contact a licensed electrician to replace the outlet with a 
properly grounded one. Do not defeat the purpose of the grounding plug!

Be careful when lifting or moving your computer or display. Be sure to use correct 
lifting procedures, lifting with your legs. When carrying the display, make sure the 
display is facing you. Don’t carry the display by its stand. Be careful when lifting or 
moving your computer or display. Be sure to use correct lifting procedures, lifting 
with your legs. When carrying the display, make sure the display is facing you. Don’t 
carry the display by its stand.

Electrical equipment may be hazardous if misused. Operation of this product by 
children must always be supervised by an adult. Do not allow children access to the 
interior of any electrical product and do not permit them to handle any cables.

· Warning:  Do not attempt to open or service the liquid cooling system. Opening the 
liquid cooling system may damage your equipment, and such damage may not be 
covered by the limited warranty on your computer.
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For service or questions about your warranty, contact an Apple Authorized Service 
Provider or Apple. Service and support information is included with your computer's 
documentation.

Apple and the Environment
At Apple, we recognize our responsibility to minimize the environmental impacts of our 
operations and products. 

For More Information
Go to www.apple.com/environment/summary.html.

General Maintenance
If you need to clean the computer or display beyond wiping it down with a clean cloth, 
follow these instructions:

1 Turn your computer and display off.

2 Disconnect the computer power cable from the electrical outlet or power strip. If your 
display is connected to an outlet, disconnect it as well.

3 Disconnect the display’s cables from the computer.

4 Clean the display screen with soft, lint-free paper or cloth dampened with mild soap 
and water.

5 Wipe the computer or display case surfaces lightly with a clean, soft cloth dampened 
with water.

Important:  Don’t use alcohol, aerosol sprays, solvents, or abrasives that might damage 
the finish on the case.

· Warning:  Always operate your computer in an upright position. In the unlikely event 
that coolant leaks in or from your computer, disconnect all electrical power to the 
computer and do not restart it. Contact an Apple Authorized Service Provider or 
Apple for information about servicing your computer. 

After disconnecting electrical power, you can clean up coolant using an absorbent 
cloth. Avoid inhaling or direct contact with skin. Coolant may cause minor skin 
irritation. If coolant contacts skin, wash well with soap and water. If coolant contacts 
eyes, rinse thoroughly with water. Dispose of all clean-up materials in accordance with 
your local environmental laws, regulations, and guidelines. 

Coolant may be harmful if swallowed. Material Safety Data Sheets (MSDS) are 
available at www.apple.com/environment/resources/msds.html.

· Warning:  Do not spray liquid directly onto the display screen. Liquid could drip inside 
the display and cause electrical shock.
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Protecting Your Optical Drive
To keep your optical drive working properly:
Â Position your computer so that the drive tray doesn’t bump into anything when it 

opens.
Â Close the drive when you’re not using it.
Â Do not put anything on the drive tray when it is open.
Â Do not touch the optical drive lens with your fingers. Do not wipe the lens with a 

paper towel or other abrasive surface. If you need to clean the lens, see an Apple 
Authorized Service Provider for a lens cleaner.

Â Keep your computer away from any source of moisture.

Maintaining Your Display
To maintain your display and ensure its long life:
Â Do not press on the surface of the display screen.
Â Do not write on the screen or touch the screen with a sharp object.
Â If you will not be using your display and computer for a day or more, turn off the 

computer and display or use Energy Saver.
Â Turn off your display, turn down the brightness, or use a screen saver program 

that dims or varies the image on the screen when the computer is idle for a 
prolonged time. 

Important Ergonomic and Health-Related Information
Here are some guidelines for adjusting the furniture in your office to reduce glare and 
to accommodate your physical size and shape.
Â An adjustable chair that provides firm, comfortable support is best. Adjust the height 

of the chair so your thighs are tilted slightly and your feet are flat on the floor. 
The back of the chair should support your lower back (lumbar region). Follow the 
manufacturer’s instructions for adjusting the backrest to fit your body properly.

Â When you use the computer keyboard, your shoulders should be relaxed. Your upper 
arm and forearm should form an approximate right angle, with your wrist and hand 
in roughly a straight line. 
You may have to raise your chair so your forearms and hands are at the proper angle 
to the keyboard. If this makes it impossible to rest your feet flat on the floor, you can 
use a footrest with adjustable height and tilt to make up for any gap between the 
floor and your feet. Or you can lower the desktop to eliminate the need for a footrest. 
Another option is to use a desk with a keyboard tray that’s lower than the regular 
work surface.

Â Position the mouse at the same height as your keyboard. Allow adequate space to 
use the mouse comfortably.
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Â Arrange the display so the top of the screen is slightly below your eye level when 
you’re sitting at the keyboard. The best distance from your eyes to the screen is up to 
you, although most people seem to prefer 18 to 28 inches (45 to 70 cm). 

Â Position the display to minimize glare and reflections on the screen from overhead 
lights and nearby windows. If possible, use a tiltable display stand. The stand lets you 
set the display at the best angle for viewing, helping to reduce or eliminate glare 
from lighting sources you can’t move.

For more information about health, safety, and maintenance, go to the Apple 
ergonomic website at www.apple.com/about/ergonomics.

Thighs tilted slightly

Shoulders relaxed

Screen positioned to avoid
reflected glare

Forearms and hands
in a straight line

Forearms level
or tilted slightly

Lower back supported

Feet flat on the floor
or on a footrest

Top of the screen at or slightly below
eye level (You may need to adjust the
height of your display by raising or
lowering your work surface.)

Clearance under work surface

45–70 cm (18–28 in.)
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C Connecting to the Internet

You can use your computer to browse the World Wide 
Web, send email to friends and family, and chat in real 
time over the Internet. Use this detailed guide to connect 
to the Internet.

When you first start up Mac OS X, the Setup Assistant helps you enter your Internet 
configuration information.

If you didn’t use the Setup Assistant to configure your Internet connection, you can use 
it now. Open System Preferences and click Network. Click the “Assist me” button to 
open Network Setup Assistant. If you don’t want to use Network Setup Assistant, you 
can use the information in this appendix to set up your connection manually.

There are four kinds of Internet connections:
Â Dial-up connection:  Your computer is plugged into a telephone wall jack using a 

telephone cable (with computers that include a modem).
Â High-speed DSL or cable modem connection:  Your computer is plugged into a 

special modem you get from an ISP using an Ethernet cable.
Â AirPort Extreme wireless connection:  Your computer is connected wirelessly to the 

Internet using an AirPort Extreme or AirPort Express Base Station.
Â Local area network (LAN):  Your computer is plugged into a LAN using an Ethernet 

cable. This type of connection is usually used in the workplace.

Before you connect to the Internet:
1 Set up an account with an ISP. You can find an ISP in your phone directory. Look under 

“Internet access,” “Internet service,” or “online.”

Note:  If you want to use America Online as your ISP, skip the Internet setup part of the 
Setup Assistant. You need the AOL installer application. Open the AOL Installer 
application and follow the onscreen instructions to set up AOL.

2 Gather the connection information you need from your ISP or network administrator. In 
some cases, if another computer in the same location is already connected to the 
Internet, you may be able to use its settings. 
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To find the settings on a Mac OS X computer:
Â Open the Network pane of System Preferences.
Â Choose your connection method from the Show pop-up menu. 
Â Copy the information for your configuration.

To find the settings on a Mac OS 9 computer:
Â Open the TCP/IP control panel.
Â Find the connection method in the “Connect via” pop-up menu.
Â Find the configuration in the Configure pop-up menu.
Â Copy the IP address, subnet mask, and router address from the corresponding fields.

To find the settings on a Windows PC:
The connection information on a Windows computer resides in two places.
Â To find the IP address and subnet mask, open the “Network and Internet 

Connections” control panel.
Â To find user account information, open the User Accounts control panel. 
You can write the information directly on the next few pages, then enter it in the Setup 
Assistant.

3 If you are using a dial-up modem, plug a phone cord (included with most Macintosh 
computers) into your computer’s modem port and into a phone wall jack. If you are 
using a DSL or cable modem, follow the instructions that came with the modem to 
connect it to your computer. 

4 Turn on your computer and enter information in the Setup Assistant to configure your 
Internet connection.

Note:  If you already started your computer and did not use the Setup Assistant to 
configure your Internet connection, choose Apple () > System Preferences and click 
Network. Then click “Assist me.” The Setup Assistant opens.
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Gathering the Information You Need
You can write the information you get from your Internet service provider (ISP), your 
network administrator, or your other computer on these pages, then enter it in 
Network Setup Assistant.

To set up a telephone dial-up connection, gather the following information:
Â Service provider name
Â User or account name
Â Password
Â ISP phone number
Â Alternate phone number
Â Dialing prefix to obtain an outside line

To set up a DSL, cable modem, LAN, or AirPort Extreme wireless connection:
m First, choose your connection method (ask your system administrator or your ISP, if 

you don’t know):

Â Manually
Â Using DHCP with a manual address
Â Using DHCP
Â Using BootP
Â PPP

If you’re unsure which method to use, “Using DHCP” may be a good choice, because 
the network supplies most of the required information for you automatically.

If you selected “Manually” or “Using DHCP with a manual address,” gather the following:
Â IP address
Â Subnet mask
Â Router address

Note:  If you selected “Using DHCP with a manual address,” you don’t need a subnet 
mask or router address.

If you selected “Using DHCP,” gather the following optional information (ask your ISP if 
you need it):
Â DHCP client ID
Â DNS servers
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If you selected “PPP” (for PPPoE connections), gather the following:
Â Service provider
Â Account name
Â Password
Â PPPoE service name

The information below is optional. Ask your ISP or system administrator if you need it.

Â DNS servers
Â Domain name
Â Proxy server

Entering Your Information
After gathering your specific setup information from your ISP or network administrator, 
you can click the “Assist me” button in the Network preferences pane to open Network 
Setup Assistant, or you can enter the information manually. 

To enter your information manually, follow the steps that correspond to your 
connection method.
Â Dial-up modem with Point-to-Point Protocol (PPP) connection (see page 94)
Â Cable modem, DSL, or LAN connection (page 98) using these configurations:

Â Manual
Â DHCP
Â PPPoE

Â AirPort Extreme wireless connection (see page 102)

Dial-Up Connection
A dial-up modem is the most common way to connect to the Internet. Your modem 
uses a method called Point-to-Point Protocol (PPP) to connect to an ISP.

Make sure your modem is plugged into a phone line and you have the information 
from your ISP available.

To set up Network preferences for the internal modem port: 
1 Choose Apple () > System Preferences from the menu bar. 

2 Click Network.
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3 Choose Network Port Configurations from the Show pop-up menu and select the On 
checkbox next to Internal Modem.

4 Drag Internal Modem to the top of the Port Configurations list to make it the preferred, 
or primary, network interface.

5 Choose Internal Modem from the Show pop-up menu and click PPP. 

6 Enter the information from your ISP and click Apply Now. 
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To test your Internet configuration:
1 Open the Internet Connect application (in the Applications folder).

2 Click the Internal Modem icon, if necessary.

3 Enter your dial-up telephone number, account name, and password, if necessary.

4 Click Connect.

Internet Connect dials your ISP and establishes a connection.

To connect automatically when you start an Internet application, such as a 
web browser or email:

1 Click PPP Options (in the PPP pane of Network preferences).

2 Select the “Connect automatically when needed” checkbox.

3 Click OK and Apply Now. 
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DSL, Cable Modem, or LAN Internet Connections
If you connect to the Internet using a DSL or cable modem or Ethernet LAN, ask your 
ISP or network administrator how you should configure your Internet connection:
Â Manually:  With a manual configuration, your ISP or network administrator provides 

a static IP address and other information that you enter in Network preferences.
Â Using Dynamic Host Configuration Protocol (DHCP):  With a DHCP configuration, 

the DHCP server automatically enters the information for you.
Â Using Point-to-Point Protocol over Ethernet (PPPoE):  If you use a DSL modem and 

need a user name and password to connect to the Internet, you may need to 
configure your network to use PPPoE.

Make sure you have the information from your ISP available as you configure your 
network.

To set up Network preferences for the built-in Ethernet port:
1 Choose Apple () > System Preferences from the menu bar.

2 Click Network.

3 Choose Network Port Configurations from the Show pop-up menu.

4 Select the On checkbox next to Built-in Ethernet.

5 Drag Built-in Ethernet to the top of the Port Configurations list to make it the preferred, 
or primary, network interface. 

Next, follow the instructions to configure your network manually, using DHCP, or using 
PPPoE, as instructed by your ISP or network administrator.
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Manual Configuration
Have your static IP address, router address, and subnet mask from your ISP ready. 

To set up a manual configuration: 
1 In Network preferences, choose Built-in Ethernet from the Show pop-up menu.

2 Click TCP/IP, if necessary.

3 Choose Manually from the Configure IPv4 pop-up menu.

4 Type the other information into the corresponding fields. 

5 Click Apply Now.

Once you configure your network, your connection is ready. Open your web browser 
(or another TCP/IP application) to test your Internet connection.
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DHCP Configuration
After you set up a DHCP configuration, the DHCP server automatically provides your 
network information.

To set up a DHCP configuration:
1 In Network preferences, choose Built-in Ethernet from the Show pop-up menu.

2 Click TCP/IP, if necessary.

3 Choose Using DHCP from the Configure IPv4 pop-up menu.

4 Click Apply Now.

Open your web browser (or another TCP/IP application) to test your Internet 
connection.

Note:  Unless your ISP instructs you to do otherwise, ignore the DHCP Client ID field 
and the Search Domains field.
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PPPoE Configuration
Some DSL-based ISPs use Point-to-Point Protocol over Ethernet (PPPoE). If you use a 
DSL modem and need a user name and password to connect to the Internet, check 
with your ISP to determine if you should connect using PPPoE. 

To set up a PPPoE connection:
Have your user name, password, and if required, the domain name server (DNS) 
address from your ISP available as you configure your network.

1 In Network preferences, choose Built-in Ethernet from the Show pop-up menu.

2 Click PPPoE and select “Connect using PPPoE.”

3 Type the information into the corresponding fields. If you want all users of your 
computer to use the same connection method, select “Save password.”
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Note:  To connect automatically when you start a TCP/IP application, such as a web 
browser or email, click PPPoE Options, then select “Connect automatically when 
needed” and click OK.

4 Click TCP/IP and choose either Using PPP or Manually from the Configure IPv4 pop-up 
menu, as instructed by your ISP. If you have a static IP address from your ISP, choose 
Manually and type the address in the IP Address field.

5 Type the domain name server (DNS) addresses in the DNS Servers field.

6 Click Apply Now.
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Once you configure your network, your Internet connection is ready. You can open your 
web browser or other TCP/IP application to test your connection.

Important:  If you did not select the option to connect automatically, you will need to 
open the Internet Connect application, choose the correct configuration, and then click 
Connect. For more information, choose Help > Internet Connect Help from the menu 
bar at the top of the display. 

AirPort Wireless Connection
If your Power Mac G5 has an AirPort Extreme Card installed, you can configure your 
AirPort network and Internet connection using AirPort Setup Assistant, located in the 
Utilities folder within your Applications folder. The assistant helps you configure the 
AirPort Base Station and set up your computer to use AirPort. For more information 
about your AirPort Base Station, see the AirPort Base Station Setup Guide that came with 
your base station.

If your AirPort Base Station is already configured, in most cases your AirPort Extreme 
Card is ready to access it immediately. 

To check if you have access to an AirPort network:
m Click the AirPort status icon in the menu bar and choose an AirPort network listed 

there.

If you don’t see an AirPort network listed, you can use AirPort Setup Assistant to check 
or change your settings, or you can change them using the Network pane of System 
Preferences. 
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Setting Up an AirPort Connection Manually
Gather the following information from your system administrator if you’ll be setting up 
a manual connection. 

If you’ll be connecting using DHCP, most of this information is provided to your 
computer automatically by the network, so ask your system administrator what is 
required.
Â Domain name server (DNS) addresses, if necessary
Â DHCP or manual IP address configuration
Â IP address 
Â Router address 
Â Subnet mask
Â Password, if required

Next, make sure your AirPort connection options are active in Network preferences.

To set up Network preferences for an AirPort connection:
1 Choose Apple () > System Preferences from the menu bar.

2 Click Network.

3 Choose Network Port Configurations from the Show pop-up menu.

4 Select the On checkbox next to AirPort.
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Next, follow the instructions to configure your network either manually or using DHCP, 
as instructed by your ISP or network administrator. If you’re setting up your network 
yourself, it may be easier to configure the network using DHCP, because the server 
assigns IP addresses automatically.

5 Choose AirPort from the Show pop-up menu.

6 Click TCP/IP, if necessary.

7 In the Configure IPv4 pop-up menu, choose either Manually or Using DHCP.

Â If you chose Manually, type the other information into the corresponding fields. 
Â If you chose Using DHCP, you don’t need to enter any further information unless your 

system administrator has instructed you to do so.

8 Click AirPort and select options for joining an AirPort Extreme network after restarting 
or when your computer wakes from sleep.

9 Click Apply Now.

Once you configure your AirPort settings, you are ready to connect.

To test your AirPort connection:
m Click the AirPort status icon in the menu bar and choose Turn AirPort On.

Any AirPort Extreme network in range should appear in the menu.
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Troubleshooting Your Connection
Cable Modem, DSL, and LAN Internet Connections
If you can’t connect to the Internet using your AirPort, built-in Ethernet, or internal 
modem, you can use Network Diagnostics to diagnose connection problems. Click 
“Assist me” in the network pane of System Preferences, click Diagnostics, and follow the 
onscreen instructions.

If Network Diagnostics can’t resolve the problem, there may be a problem with the 
Internet service provider (ISP) you are trying to connect to, with an external device you 
are using to connect to your ISP, or with the server you are trying to access. You can 
also try the following steps:

Check the cables and power supplies
Make sure all modem cables are firmly plugged in, including the modem power cord, 
the cable from the modem to the computer, and the cable from the modem to the wall 
jack. Check the cables and power supplies to Ethernet hubs and routers. 

Turn the modem on and off and reset the modem hardware
Turn off your DSL or cable modem for a few minutes, then turn it back on. Some ISPs 
recommend that you unplug the modem’s power cord. If your modem has a reset 
button, you can press it either before or after you turn the power off and on.

PPPoE Connections 
If you are unable to connect to your Internet service provider using PPPoE, first check 
the cables and power supplies, then turn the power off and on and reset the modem 
hardware. 

Check System Preferences settings:
1 Choose Apple () > System Preferences.

2 Click Network.

3 Choose Network Port Configurations from the Show pop-up menu. 

4 Drag Built-in Ethernet to the top of the Port Configurations list. 

5 Choose Built-in Ethernet from the Show pop-up menu. 

6 Click PPPoE. 

7 Select “Connect using PPPoE.”

8 Check the Account Name field to be sure you have entered the correct information 
from your ISP. 

9 Retype your password if you chose to save your password, to be sure it is correct. 

10 Click TCP/IP. Make sure you’ve entered the correct information from your ISP 
in this pane. 

11 Click Apply Now.
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Network Connections
If you have two or more computers attempting to share an Internet connection, be 
sure that your network is set up properly. You need to know if your ISP provides only 
one IP address or if it provides multiple IP addresses, one for each computer.

If only one IP address is used, then you must have a router capable of sharing the 
connection, also known as network address translation (NAT) or “IP masquerading.” For 
setup information, check the documentation provided with your router or ask the 
person who set up your network. The AirPort Extreme Base Station may be used to 
share one IP address among multiple computers. For information on using the AirPort 
Extreme Base Station, check the onscreen help or visit the Apple AirPort website at 
www.apple.com/airport.

If you cannot resolve the issue using these steps, contact your ISP.
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Communications Regulation Information

FCC Compliance Statement
This equipment has been tested and found to 
comply with the limits for a Class B digital device, 
pursuant to part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against 
harmful interference in a residential installation.

This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used 
in accordance with the instructions, may cause 
harmful interference to radio communications. 
However, there is no guarantee that interference will 
not occur in a particular installation. If this 
equipment does cause harmful interference to radio 
or television reception, which can be determined by 
turning the equipment off and on, the user is 
encouraged to try to correct the interference by one 
or more of the following measures:
Â Reorient or relocate the receiving antenna.
Â Increase the separation between the equipment 

and receiver.
Â Connect the equipment into an outlet on a circuit 

different from that to which the receiver is 
connected.

Â Consult the dealer or an experienced radio/TV 
technician for help.

If necessary, consult an Apple Authorized Service 
Provider or Apple. See the service and support 
information that came with your Apple product. Or, 
consult an experienced radio/television technician 
for additional suggestions. 

Important:  Changes or modifications to this product 
not authorized by Apple Computer, Inc., could void 
the EMC compliance and negate your authority to 
operate the product.

This product has demonstrated EMC compliance 
under conditions that included the use of compliant 
peripheral devices and shielded cables between 
system components. It is important that you use 
compliant peripheral devices and shielded cables 
(including Ethernet network cables) between system 
components to reduce the possibility of causing 
interference to radios, television sets, and other 
electronic devices.

Responsible party (contact for FCC matters only):
Apple Computer, Inc. Product Compliance, 
1 Infinite Loop M/S 26-A, 
Cupertino, CA 95014-2084, 
408-974-2000.

Bluetooth Information
FCC Bluetooth Wireless Compliance

The antenna used with this transmitter must not be 
colocated or operated in conjunction with any other 
antenna or transmitter subject to the conditions of 
the FCC Grant.

Bluetooth Industry Canada Statement
This Class B device meets all requirements of the 
Canadian interference-causing equipment 
regulations.

Cet appareil numérique de la Class B respecte toutes 
les exigences du Règlement sur le matériel brouilleur 
du Canada.

Bluetooth Europe—EU Declaration of Conformity
This wireless device complies with the specifications 
EN 300 328, EN 301-489, and EN 60950 following the 
provisions of the R&TTE Directive.

Industry Canada Statement
This Class B device meets all requirements of the 
Canadian interference-causing equipment 
regulations.
Cet appareil numérique de la Class B respecte toutes 
les exigences du Règlement sur le matériel brouilleur 
du Canada. 

VCCI Class B Statement

Europe - EU Declaration of Conformity
Complies with European Directives 72/23/EEC, 89/
336/EEC, and 99/5/EC.

Laser Information

Do not attempt to disassemble the cabinet 
containing the laser. The laser beam used in this 
product is harmful to the eyes. The use of optical 
instruments, such as magnifying lenses, with this 
product increases the potential hazard to your eyes. 
For your safety, have this equipment serviced only 
by an Apple-authorized service provider. 

Warning:  Making adjustments or performing 
procedures other than those specified in your 
equipment’s manual may result in hazardous 
radiation exposure.
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Because of the optical disc drive in your computer, 
your computer is a Class 1 laser product. The Class 1 
label, located in a user-accessible area, indicates that 
the drive meets minimum safety requirements. A 
service warning label is located in a service-
accessible area. The labels on your product may 
differ slightly from the ones shown here.

Exposure to Radio Frequency Energy
The radiated output power of the optional AirPort 
Extreme Card is far below the FCC radio frequency 
exposure limits. Nevertheless, it is advised to use the 
wireless equipment in such a manner that the 
potential for human contact during normal 
operation is minimized.

Mouse and Keyboard Information
The Apple optical mouse is a Class 1 LED product. 
This product complies with the requirements of 
European Directives 72/23/EEC and 89/336/EEC.

It also complies with the Canadian ICES-003 Class B 
Specification.

High-Risk Activities Warning
This computer system is not intended for use in the 
operation of nuclear facilities, aircraft navigation or 
communications systems, or air traffic control 
machines, or for any other uses where the failure of 
the computer system could lead to death, personal 
injury or severe environmental damage.

ENERGY STAR® Compliance
As an ENERGY STAR® partner, Apple has determined 
that standard configurations of this product meet 
the ENERGY STAR® guidelines for energy efficiency. 
The ENERGY STAR® program is a partnership with 
office product equipment manufacturers to promote 
energy-efficiency. Reducing energy consumption of 
office products saves money and reduces pollution 
by eliminating wasted energy.

Disposal and Recycling Information
The backlight lamp in this product contains mercury. 
Dispose according to local, state, and federal laws. 

For information about Apple’s recycling program, go 
to www.apple.com/environment/summary.html

Battery Disposal
Dispose of batteries according to your local 
environmental laws and guidelines.

Nederlands: Gebruikte batterijen kunnen worden 
ingeleverd bij de chemokar of in een speciale 
batterijcontainer voor klein chemisch afval (kca) 
worden gedeponeerd.

Deutschland: Das Gerät enthält Batterien. Diese 
gehören nicht in den Hausmüll. Sie können 
verbrauchte Batterien beim Handel oder bei den 
Kommunen unentgeltlich abgeben. Um 
Kurzschlüsse zu vermeiden, kleben Sie die Pole der 
Batterien vorsorglich mit einem Klebestreifen ab.

Taiwan:

Telephone and Apple 56K Modem 
Information
Notify Your Telephone Company
Some telephone companies require that you notify 
the local business office when you hook up a 
modem to their lines. 

Information You Need in the United States 
The internal modem complies with Part 68 of the 
FCC rules. On the back of this equipment is a label 
that contains, among other information, the FCC 
registration number and ringer equivalence number 
(REN). If requested, provide this information to your 
telephone company. 
Â Ringer equivalence number (REN):  0.1B (part 

numbers M9455 and M9457) and 0.6B (part 
number M9454). The REN is useful for determining 
the quantity of devices you may connect to your 
telephone lines and still have all those devices ring 
when your telephone number is called. In most, 
but not all areas, the sum of the RENs of all devices 
connected to one line should not exceed five (5.0). 
To be certain of the number of devices you may 
connect to your line, as determined by the REN, 
you should contact your local telephone company 
to determine the maximum REN for your calling 
area. 

Â Telephone jack type:  USOC, RJ-11 An FCC-compliant 
telephone cord and modular plug are provided 
with this equipment. This equipment is designed 
to be connected to the telephone network or 
premises wiring using a compatible modular jack 
that complies with Part 68 rules. See the 
installation instructions for details.

Telephone Line Problems
If your telephone doesn’t work, there may be a 
problem with your telephone line. Disconnect the 
modem to see if the problem goes away. If it doesn’t, 

Class 1 label Service warning label
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report the problem either to your local telephone 
company or to your company’s telecommunications 
department. 

If disconnecting the modem eliminates the problem, 
the modem itself may need service. See the service 
and support information that came with your Apple 
product for instructions on how to contact Apple or 
an Apple Authorized Service Provider for assistance. 

If you do not disconnect your modem when it is 
adversely affecting the telephone line, the telephone 
company has the right to disconnect your service 
temporarily until you correct the problem. The 
telephone company will notify you as soon as 
possible. Also, you will be informed of your right to 
file a complaint with the FCC. 

The telephone company may make changes in its 
facilities, equipment, operations, or procedures that 
could affect the operation of your equipment. If this 
happens, the telephone company will provide 
advance notice in order for you to make the 
necessary modifications to maintain uninterrupted 
service. 

The internal modem will not work with party lines, 
cannot be connected to a coin-operated telephone, 
and may not work with a private branch exchange 
(PBX). 

Telephone Consumer Protection Act 
The Telephone Consumer Protection Act of 1991 
makes it unlawful for any person to use a computer 
or other electronic device to send any message via a 
telephone fax machine unless such message clearly 
contains, in a margin at the top or bottom of each 
transmitted page or on the first page of the 
transmission, the date and time it was sent and an 
identification of the business, other entity, or 
individual sending the message and the telephone 
number of the sending machine of such business, 
entity, or individual.

Information You Need in Canada 
The Industry Canada (IC) label identifies certified 
equipment. This certification means that the 
equipment meets certain telecommunications 
network protective, operational, and safety 
requirements. The Department does not guarantee 
the equipment will operate to a user’s satisfaction. 

Before installing this equipment, make sure that you 
are permitted to connect to the facilities of the local 
telecommunications company. Be sure you use an 
acceptable method of connection to install the 
equipment. In some cases, you may extend the 
company’s internal wiring for single-line individual 
service by means of a certified telephone extension 

cord. Be aware, however, that compliance with these 
conditions may not prevent degradation of service 
in some situations. 

Repairs to certified equipment should be made by 
an authorized Canadian maintenance facility 
designated by the supplier. Any equipment 
malfunctions or repairs or alterations that you make 
to this equipment may cause the 
telecommunications company to request that you 
disconnect the equipment. 

In Canada, contact Apple at:  7495 Birchmount Road, 
Markham, Ontario, L3R 5G2, 800-263-3394

Users should not attempt to make such connections 
themselves, but should contact the appropriate 
electric inspection authority or electrician.
Â Load number:  0.1 (part numbers M9455 and 

M9457) and 0.2 (part number M9454). The load 
number (LN) assigned to each terminal device 
denotes the percentage of the total load to be 
connected to the telephone loop that is used by 
the device, to prevent overloading. The 
termination of a loop may consist of any 
combination of devices, subject only to the 
requirement that the sum of the load numbers of 
all devices does not exceed 100.

Â Telephone jack type:  CA-11

Informations Destinées aux Utilisateurs Canadiens
L’étiquette d’Industrie Canada identifie un matériel 
homologué. Cette étiquette certifie que le matériel 
est conforme à certaines normes de protection, 
d’exploitation et de sécurité des réseaux de 
télécommunications. Le Ministère n’assure toutefois 
pas que le matériel fonctionnera à la satisfaction de 
l’utilisateur.

Avant d’installer ce matériel, l’utilisateur doit 
s’assurer qu’il est permis de la raccorder au réseau de 
l’enterprise locale de télécommunication. Le matériel 
doit également être installé en suivant une méthode 
acceptée de raccordement. Dans certains cas, le 
câblage appartenant à l’enterprise utilisé pour un 
service individuel à ligne unique peut être prolongé 
au moyen d’un dispositif homologué de 
raccordement (cordon prolongateur téléphonique).

L’abonné ne doit pas oublier qu’il est possible que la 
conformité aux conditions énoncées ci-dessus 
n’empêche pas la dégradation du service dans 

Warning:  Users should ensure for their own 
protection that the electrical ground connections 
of the power utility, telephone lines, and internal 
metallic water pipe system, if present, are 
connected together. This precaution may be 
particularly important in rural areas. 
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certaines situations. De fait, les enterprises de 
télécommunication ne permettent pas que l’on 
raccorde un matériel aux prises d’abonnés, sauf dans 
les cas précis prévus par les terifs particuliers de ces 
enterprises.

Les réparations de matériel homologué doivent être 
effectuées par un centre d’entretien canadien 
autorisé désigné par la fournisseur. La compagnie de 
télécommunications peut demander à l’utilisateur de 
débrancher un appareil suite à des réparations ou à 
des modifications effectuées par l’utilisateur ou en 
raison d’un mauvais fonctionnement.

Veuillez contacter Apple pour des informations 
supplémentaires:

Apple Canada, Inc.
7495 Birchmount Road
Markham, Ontario
Canada L3R 5G2

Service à la clientèle d’Apple Canada :  800-263-3394

L’utilisateur ne doit pas tenter de faire ces 
raccordements lui-même; il doit avoir recours à une 
service d’inspection des installations électriques ou à 
un électricien, selon le cas.
Â Numéro de charge :  0.2 L’indice de charge (IC) 

assigné à chaque dispositif terminal indique, pour 
éviter toute surcharge, le pourcentage de la 
charge totale qui sera raccordée à un circuit 
téléphonique bouclé utilisé par ce dispositif. La 
terminaison du circuit bouclé peut être constituée 
de n’importe quelle combinaison de dispositifs 
pourvu que la somme des indices de charge de 
l’ensemble des dispositifs ne dépasse pas 100.

Â Type de prise téléphonique :  CA-11

Information You Need in the United Kingdom
This terminal equipment is intended for direct 
connection to the analogue Public Switched 
Telecommunications Network and is approved for 
use within the United Kingdom with the following 
features:
Â Modem facility
Â Autocalling facility
Â Autoanswer facility
Â DTMF signaling

Operation in the absence of proceed indication or 
upon detection of proceed indication

This product is in conformity with relevant 
regulatory standards following the provisions of 
European Council Directives 73/23/EEC (Low Voltage 
Directive) and 89/336/EEC amended by 92/31/EEC 
(EMC Directive).

Informationen fur Deutschland
Diese Modem-Karte ist als Endeinrichtung 
vorgesehen und muss an ein TAE mit F-Kodierung 
angeschlossen werden. Diese Endeinrichtung ist in 
Konformität gemäss Niederspannungsrichtlinie 73 / 
23 / EWG sowie EMC-Richtlinien 89 / 336 / EWG und 
92 / 31 / EWG.

Informations pour la France
Ce matériel est conforme aux normes applicables de 
sécurité éléctrique d’après la directive 73 / 23 / CEE 
et aux normes applicables de comptabilité 
éléctromagnétique d’après la directive 89 / 336 / 
CEE, modifié par la directive 92 / 31 / CEE.

Information You Need in Australia
All telecommunications devices are required to be 
labelled as complying to the Australian 
telecommunications standards, ensuring the health 
and safety of the operator and the integrity of the 
Australian telecommunications network. To provide 
compliance with the Australian Communications 
Authority’s technical standards, please ensure that 
the following AT commands are maintained:
Â ATB0 (ITU/CCITT operation)
Â AT&G0 (no guard tone)
Â AT&P1 (33/66 pulse dial make/break ratio)
Â ATS0 = 0 or ATS0 = 1 (no answer or answer greater 

than one ring)
Â ATS6 = 95 (DTMF period between 70–255 ms)
Â ATS11 = 95 (DTMF period between 70–255 ms)

For calls that are automatically generated, a total of 
three call attempts are allowed to a telephone 
number, with a minimum period between calls of 2 
seconds. If the call does not connect after three 
attempts, 30 minutes must expire before automatic 
redialing may be initiated. Failure to set the modem 
(and any associated communications software) to 
the above settings may result in the modem being 
non-compliant with Australian telecommunications 
standards. Under these circumstances a user could 
be subject to significant penalties under the 
Telecommunications Act 1997.

This modem must be properly secured in order for 
you to use it. Telecommunications network voltages 
exist inside the computer and the 
telecommunications line connection must be 
removed before opening the computer.

Avertissement :  Pour sa propre protection, 
l’utilisateur doit s’assurer que tout les fils de mise à 
la terre du secteur, des lignes téléphoniques et les 
canalisations d’eau métalliques, s’il y en a, soient 
raccordés ensemble. Cette précaution est 
particulièrement importante dans les régions 
rurales.
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Information You Need in New Zealand
This modem is fully approved to operate on the New 
Zealand telecommunications network under 
Telepermit number PTC 211/04/002 (part numbers 
M9455 and M9457) and PTC 211/01/062 (part 
number M9454). All telecommunications devices are 
required to hold a Telepermit and be labelled 
accordingly with the approved Telepermit number to 
comply with the New Zealand telecommunications 
standards, ensuring the health and safety of the 
operator and the integrity of the New Zealand 
telecommunications network. To ensure compliance, 
all calls that are automatically generated should not 
make more than 10 call attempts to the same 
number within any 30 minute period with a 
minimum period between calls of 30 seconds. 

Failure to adhere to these standards may result in 
the modem being non-compliant with New Zealand 
Telecom standards. Under these circumstances a 
user could be subject to significant penalties.

Important:  The grant of a Telepermit for any item of 
terminal equipment indicates that only Telecom has 
accepted that the item complies with minimum 
conditions for connection to its network. It indicates 
no endorsement of the product by Telecom, nor 
does it provide any sort of warranty. Above all, it 
provides no assurance that any item will work 
correctly in all respects with another item of 
Telepermitted equipment of a different make or 
model, nor does it imply that any product is 
compatible with all of Telecom’s network services.

LL3218Q87.book  Page 111  Wednesday, March 16, 2005  6:28 PM



LL3218Q87.book  Page 112  Wednesday, March 16, 2005  6:28 PM



     113

In
de

xIndex

A
adapter

DVI to ADC  7
DVI to Composite  7
DVI to VGA  7

AGP 8X Pro graphics  19
AGP card  64
air deflector  47
AirPort Extreme  82

antenna  17, 69
base station  37
card  19, 36
connection  94
connector  19
setting up  102
setting up a connection  93

analog audio  31, 83
line-in  17, 83
line-out  17, 83

B
battery  19

replacing  69
Bluetooth  38, 42, 82

antenna  9, 17, 38
file exchange  40
module not user-installable  40
pairing  39
sending a file  40
setting up a device  39

C
cable modem  97

setting up  93
Cat 5  34
CD-RW  80
Combo drive  15, 19
computer won’t turn on  72
connecting

mobile phone  39
PDA and Bluetooth  39
TV  25

VCR  25
video device  25

D
DDR SDRAM  19, 49
DHCP  94

configuration  99
dial-up

connection  94
modem  94

dimensions  84
DIMMs  49
discharge static  44
display  10, 79

extended desktop  23
mirroring  23
multiple  23

disposal and recycling  108
DSL  94, 97

modem  93
DVD  80
DVD-ROM/CD-RW Combo drive  15, 19
DVI port  17
Dynamic Host Configuration Protocol (DHCP)  97

E
eject disc  31
ergonomic information  88
Ethernet  17, 34, 77, 81

F
FireWire  15, 17, 28, 81
FireWire Target Disk Mode  29
Force Quit  75
front fan assembly  48

G
general maintenance  87

H
hard disk drive  19
headphone jack  15, 31, 83
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installing

AGP card  64
AirPort Extreme Card  68
applications  76, 77
battery  69
Classic support  76, 77
Mac OS 9  76, 77
Mac OS X  76, 77
memory  49
PCI/PCI-X cards  66
Serial ATA drives  57
SuperDrive  60

Internet
configuration  96
connecting to  12, 102
problems connecting  105

Internet service provider  91
ISP  91
iTunes  32

K
keyboard  22
keyboard extender cable  9

L
LAN  97

connection  93, 94
latch  17, 55
liquid cooling system  86

M
maintenance  87
manual Internet configuration  98
manually using DHCP router option  93
Material Safety Data Sheet  87
modem  17, 36, 81

cable  91
DSL  91
not user-installable  36

mouse  23
multiple displays  23

N
network connections  106
Network Setup Assistant  91
no image on screen  74

O
operating environment  84
optical digital audio  17, 30, 82
optical drive  15, 19, 31, 56

P
PCI slots  17, 19
Point-to-Point Protocol  94, 97, 100
power button  9, 15
power cord  6
power socket  17
PPPoE  94

configuration  100
connections  94

problems
connecting to Internet  105

processor  79
protective film  6

R
reset the PRAM  72
ribbon cable  60

S
safety  85
safety information  85
screen freezes  75
SDRAM  79
Serial ATA drive  56
serial number  77
setting up  93

to connect manually  94
shut down  13, 44
shut off power  5
sleep  12, 15, 40
static IP address  98
status light  15, 72
SuperDrive  15, 19, 33

T
telephone dial-up connection  93
testing your Internet configuration  96

U
unable to eject a disc  72
USB  9, 15, 17, 26, 81, 84
using DHCP option  93
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